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Read Me First

= Notes on Online Manual Usage
= How to Print

Notes on Online Manual Usage

» Reproduction, diversion or copying of any text, photo or image published in the Online Manual
(hereinafter referred to as "this guide"), in whole or in part, is prohibited.

* In principle, Canon shall change or delete the contents of this guide without prior notice to customers.
In addition, Canon may suspend or stop the disclosure of this guide due to unavoidable reasons.
Canon shall not be liable for any damage suffered by customers as a result of changes in or deletion
of information in this guide, or suspension/stoppage of disclosure of this guide.

» Although the contents of this guide have been prepared with utmost care, please contact the service
center if you find any incorrect or missing information.

* In principle, the descriptions in this guide are based on the product at the time of its initial sale.

» This guide does not disclose the manuals of all the products sold by Canon. See the manual supplied
with the product when using a product that is not described in this guide.

How to Print

Use the print function of your Web browser to print this guide.

To set to print background colors and images, follow the steps below.

7> Note

* In Windows 8, print in the desktop version.

* In Internet Explorer 9 or 10

1. Select {@} (Tools) > Print > Page setup....
2. Select the Print Background Colors and Images checkbox.

* In Internet Explorer 8

1. Press the Alt key to display the menus.

Alternatively, from Tools, select Toolbars > Menu Bar to display the menus.
2. Select Page Setup... from the File menu.
3. Select the Print Background Colors and Images checkbox.

* In Mozilla Firefox

1. Press the Alt key to display the menus.
Alternatively, click Firefox, then select Menu Bar from the right arrow of Options to display the
menus.

2. Select Page Setup... from the File menu.

3. Select the Print Background (colors & images) checkbox in Format & Options.



How to Use the Online Manual

Symbols Used in This Document

% Warning
Instructions that, if ignored, could result in death or serious personal injury caused by incorrect
operation of the equipment. These must be observed for safe operation.

8 Caution
Instructions that, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

32 Important
Instructions including important information. To avoid damage and injury or improper use of the
product, be sure to read these indications.

7> Note

Instructions including notes for operation and additional explanations.

Instructions explaining basic operations of your product.

> Note

* Icons may vary depending on your product.

Touch-enabled Device Users

For touch actions, you need to replace "right-click" in this document with the action set on the operating
system. For example, if the action is set to "press and hold" on your operating system, replace "right-click"

with "press and hold."



Trademarks and Licenses

» Microsoft is a registered trademark of Microsoft Corporation.

» Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or
other countries.

* Mac, Mac OS, AirPort, Safari, Bonjour, iPad, iPhone and iPod touch are trademarks of Apple Inc.,
registered in the U.S. and other countries. AirPrint and the AirPrint logo are trademarks of Apple Inc.

* 10S is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

» Google Cloud Print, Google Chrome, Android and Google Play are either registered trademarks or
trademarks of Google Inc.

» Adobe, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB (1998) are either
registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries.

» Photo Rag is a trademark of Hahnemdhle FineArt GmbH.

* Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.

+ All other company names and products mentioned herein may be trademarks or registered trademarks
of their respective companies.

»» Note

» The formal name of Windows Vista is Microsoft Windows Vista operating system.




Enter keywords in the search window and click E (Search).

You can search for target pages in this guide.

Entry example: "(your product's model name) load paper”, "(your product's model name) 1000"

Search Tips

You can search for target pages by entering keywords in the search window.

Canon » Language
Search Tips B

Online Manual

You can see manuals of your product and applications.

Product Manuals

You can learm how to handle and operate your product.

»» Note

» The displayed screen may vary.

Searching for Functions

You can find target pages easily by entering your product's model name and a keyword for the function
you want to learn about.

Example: When you want to learn how to load paper
Enter "(your product's model name) load paper" in the search window and perform a search
* Troubleshooting Errors

You can obtain more accurate search results by entering your product's model name and a support
code.

Example: When the following error screen appears
Enter "(your product's model name) 1000" in the search window and perform a search



Cancn BN scries N

poor Code ; 1000

Paper has fun aut.
Mada Type : Plain Paper
Fage Size : Letler B.5"%11" 22¢28cm

1. Load paperinto the rear bray, 2, Pressihe printer’s Stat
button

If Emaor Parsicts

»» Note

» The displayed screen varies depending on your product.

» Searching for Application Functions

You can find target pages easily by entering your application's name and a keyword for the function you
want to learn about.

Example: When you want to learn how to print collages with My Image Garden
Enter "My Image Garden collage" in the search window and perform a search

» Searching for Reference Pages

You can search for reference pages described in this guide by entering your model name and a page
title.
You can find reference pages more easily by entering the function name as well.

Example: When you want to browse the page referred to by the following sentence on a scanning
procedure page

Refer to "Color Settings Tab" for your model from Home of the Online Manual for details.

Enter "(your product's model name) scan Color Settings Tab" in the search window and perform a
search
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Window Used in Operation Explanation

In this guide, most of the operations are described based on the windows displayed when Windows 8
operating system (called Windows 8 below) is used.
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Useful Functions Available on the Machine

The following useful functions are available on the machine.
Enjoy pleasant photography experience by utilizing various functions.

»Useful Functions Available from Applications and the Main Unit

You can create items such as collages easily or download delightful
printing materials, and print them.

»Helpful Functions Available Through the Network

You can print more conveniently through integration with smartphones and
other devices or with services on the web.

12



Useful Functions Available from Applications and the Main Unit

On the machine, the following useful functions are available from applications and the main unit.

* Print Photos Easily
* Download Content Materials
* Print Photos on Facebook

Print Photos Easily Using an Application

Organize Images Easily

In My Image Garden, you can register the names of people and events to photos.
You can organize photos easily as you can display them not only by folder but also by calendar, event,
and person. This also allows you to find the target photos easily when you search for them later on.

<Calendar View>

<People View>

Display Recommended Items in Slide Shows

Based on the information registered to photos, Quick Menu automatically selects the photos on your
computer and creates recommended items such as collages and cards. The created items appear in
slide shows.

13



ST

If there is an item you like, you can easily print it in just two steps.

1. In Image Display of Quick Menu, select the item you want to print.
2. Print the item with My Image Garden.

Place Photos Automatically

Delightful items are created easily as the selected photos are placed automatically according to the
theme.

Other Various Functions

My Image Garden has many other useful functions.

Refer to "What You Can Do with My Image Garden" for details.

Download a Variety of Content Materials

CREATIVE PARK

A "printing materials site" where you can download all the printing materials for free.
Various types of content such as seasonal cards and paper crafts that can be made by assembling

14



paper parts are provided.
It is easily accessible from Quick Menu.

CREATIVE PARK PREMIUM

A service where customers using models that support PREMIUM Contents can download exclusive
printing materials.

PREMIUM Contents can be downloaded easily via My Image Garden. Downloaded PREMIUM
Contents can be printed directly with My Image Garden.

To download PREMIUM Contents, make sure that genuine Canon ink tanks/ink cartridges are installed

for all colors on a supported printer.

15» Note

» The designs of PREMIUM Contents provided in this page are subject to change without prior
notice.

Print Photos on Facebook Easily Using a Facebook App "Print Your Days"

Use Print Your Days to collect Facebook photos of memories of parties and travel, recent activity of your
family and friends, your hobbies, etc., then create and print a work of art.
Print Your Days is available from the Print Your Days Facebook page.

Print and @njoy the

excilement and

15



Helpful Functions Available Through the Network

The following useful functions are available on the machine.

Enjoy even more pleasant photography experience by utilizing various functions.

Use App from Various Environments by Using PIXMA Cloud Link
Upload scanned images to the web

Print web data easily

Print by using Google Cloud Print

Print directly from your iPad, iPhone, or iPod touch

Manage Your Printer from a Remote Location by Using Remote Ul
Print Easily by Sending E-mail from Your Computer or Smartphone
Print easily from your smartphone by using PIXMA Printing Solutions
Printing with Windows RT

LR 2R 2R BB 2R 2 2 AR

Use App from Various Environments by Using PIXMA Cloud Link

By using PIXMA Cloud Link, you can access an application that supports this service and use it directly
without using your computer. In addition to printing photos and documents from various applications, you
can register and manage applications.

Refer to "Use PIXMA Cloud Link" for details.

Upload Scanned Images Easily to the Web

If you use Evernote or Dropbox on your computer, you can easily upload scanned images to the web.
Uploaded images can be utilized from other computers, smartphones, etc.

Refer to "Online Storage Integration Function" for details.

o

Print Photos on Photo-Sharing Services or Print Web Template Forms
Easily from the Machine

You can directly print photos on photo-sharing services or template forms offered on the web without
using a computer.

¢ Online Album Photo Print

You can access photo-sharing services on the web from the machine and directly print photos in
online albums (such as Picasa Web Albums) while checking them on the printer screen.

16



* Web Template Form Print

Canon offers various template forms including seasonal stationery and calendars on the web. You
can download and print the template forms you want anytime, as much as you need, by operating the
machine only.

Print in Various Environments with Google Cloud Print

The machine is compatible with Google Cloud Print (Google Cloud Print is a service provided by Google
Inc.).

By using Google Cloud Print, you can print from anywhere with applications or services supporting Google
Cloud Print.

Refer to "Printing with Google Cloud Print" for details.

Print Directly from iPad, iPhone, or iPod touch with Apple AirPrint

The machine is compatible with the AirPrint function of Apple iOS devices.

You can directly print e-mails, photos, web pages, etc. from iPad, iPhone, or iPod touch to the machine
over wireless LAN.

Refer to "Printing from AirPrint Compliant Device" for details.

17



Manage Your Printer from a Remote Location by Using Remote Ul

By using Remote Ul, you can set up this machine, check the machine status, and even perform
maintenance from your computer or smartphone.

Because you can use this service from a remote location through the network, you can check printer
information even when you're out away from the printer.

Refer to "Using Remote Ul" for details.

Print Easily by Sending E-mail from Your Computer or Smartphone

By using Print from E-mail, you can easily print a photo or document saved on your computer or
smartphone just by attaching it to an e-mail.

You can easily print from your travel destination or an outside location. You can even let friends and
family print on the printer by setting up your printer beforehand.

Refer to "How to Use Print from E-mail" for details.

Print Easily from a Smartphone with PIXMA Printing Solutions

Use PIXMA Printing Solutions to easily print photos saved on a smartphone wirelessly.
You can also receive scanned data (PDF or JPEG) directly on a smartphone without using a computer.

PIXMA Printing Solutions can be downloaded from App Store and Google Play.

Printing with Windows RT

When you use Windows RT, printing is easy because you simply connect this machine to the network.

For information about connecting to the network, see here.

When the connection is complete, the Canon Inkjet Print Utility software, which allows you to specify
detailed print settings, is downloaded automatically.

By using Canon Inkjet Print Utility, you can check the printer status and specify detailed print settings.
(The available functions will differ depending on your usage environment and connection method.)

18



Online Storage Integration Function

The machine can integrate with online storage services such as Evernote.

Integration with Online Notetaking Service [Fd "Evernote"

If an Evernote client application is installed on your computer, you can import scanned images into the
application and upload them to the Evernote server.

The uploaded images can be browsed from other computers, smartphones, etc.

To use Evernote, you need to create an account. See the "CREATE ACCOUNT" page of Evernote for
account creation.

» Settings

In the Settings Dialog Box of IJ Scan Utility, select the item you want to set, then select Evernote for
Send to an application in Application Settings.
Refer to "Settings Dialog Box" for your model from Home of the Online Manual for details.

3% Important

» The Evernote service features are subject to change or termination without prior notice.

19



Printing with Google Cloud Print

The machine is compatible with Google Cloud Print™ (Google Cloud Print is a service provided by Google
Inc.).

By using Google Cloud Print, you can print from anywhere with applications or services supporting Google
Cloud Print.

1. Preparations for Printing with Google Cloud Print

2. Printing from Computer or Smartphone with Google Cloud Print

2% Important

* LAN connection with the machine and Internet connection are required to register the machine and to

print with Google Cloud Print. Internet connection fees apply.
+ This function may not be available depending on the country or region you live in.

20



Preparations for Printing with Google Cloud Print

To print with Google Cloud Print, you need to get Google account and register the machine with Google
Cloud Print in advance.

= Getting Google Account

If you already have Google account, register the machine.

= Registering the Machine with Google Cloud Print

Getting Google Account

First, get your Google account in order to register the machine with Google Cloud Print.

Access to Google Cloud Print with the web browser on the computer or the mobile device, then register
the required information.

Google

Cloud Print (Beta)

Coess and share your prinkers online with Google Cloud Print Signn

Emmii

Pasoword

. Print from anyahere
L 8K R Beim ar COMPURET OF SiMa Pt

5 wlul ESIRds

‘ Ielamage your prinber

e o psl pohs a8d pSled Slaten Snhta

"‘ l Shared aoless

* The screen above may change without prior notice.

Registering the Machine with Google Cloud Print

Register the machine with Google Cloud Print.

The authentication procedure using the web browser on the computer or the mobile device is required in
the process of registering. Because the authentication URL is printed from machine when the
authentication process is performed, prepare A4 or Letter-sized plain paper.

32 Important

* LAN connection with the machine and Internet connection are required to register the machine and to
print with Google Cloud Print. Internet connection fees apply.
« |If the machine's owner changes, delete the machine from Google Cloud Print.

1. Make sure that the machine is turned on.

If your printer has a LCD monitor

2. Display the Home screen.

21



3. Select m Setup.

&
4. Select Web service setup -> Web service connection setup -> Google
Cloud Print setup -> Register with Google Cloud Print.

P Note

+ If you have already registered the machine with Google Cloud Print, the confirmation
message to re-register the machine is displayed.

5. When the confirmation screen to register the machine is displayed, select Yes.

6. Select a display language on the print setting screen of Google Cloud Print.

The confirmation message to print the authentication URL is displayed.

7. Load A4 or Letter-sized plain paper, then select OK.

The authentication URL is printed.

8. Ensure that the authentication URL is printed, select Yes.

9. Perform the authentication process using the web browser on the computer or the
mobile device.
Access to the URL using the web browser on the computer or the mobile device and perform the

authentication process following the on-screen instructions.

> Note

» Perform the authentication process with your Google account which you have gotten in
advance.

10. When the message that the registration is complete is displayed on the LCD of the
machine, select OK.

When authentication process is complete properly, the registration items are displayed. When
authentication process is complete, you can print the data with Google Cloud Print.

When authentication process is not complete properly and the error message is displayed, select
OK. When the confirmation message to print the authentication URL is displayed, print the
authentication URL, then perform the authentication process on the computer again.

If your printer does not have a LCD monitor

2. Remote Ul startup

3. Select Google Cloud Print setup -> Register with Google Cloud Print

22



> Note

* If you have already registered the machine with Google Cloud Print, the confirmation

message to re-register the machine is displayed.

4. When the confirmation screen to register the machine is displayed, select Yes.

5. In the print setup for Google Cloud Print, select the display language, and then select
Authentication.

6. When the registration completion message appears, select OK.

Deleting the Machine from Google Cloud Print

If the machine's owner changes or if you want to re-register the machine, delete the machine from Google
Cloud Print by following the steps below.

1. Make sure that the machine is turned on.

If your printer has a LCD monitor

2. Display the Home screen.

3. Select m Setup.

>
4. Select Web service setup -> Web service connection setup -> Google Cloud
Print setup -> Delete from Google Cloud Print.

5. When the confirmation screen to delete the machine is displayed, select Yes.

If your printer does not have a LCD monitor

2. Remote Ul startup

3. Select Google Cloud Print setup -> Delete from Google Cloud Print.

4. When the confirmation screen to delete the machine is displayed, select Yes.

23



Printing from Computer or Smartphone with Google Cloud Print

When you send print data with Google Cloud Print, the machine receives the print data and prints it
automatically if the machine is turned on.

When printing from a computer, smartphone, or other external device with Google Cloud Print, load paper
into the machine in advance.

Sending the Print Data with Google Cloud Print

1. Make sure that the machine is turned on.

»» Note

« If you want to send the print data from an outside location, turn on the machine in advance.

2. Print from the computer or smartphone.

The figure below is an example of when printing from the web browser corresponding with Google
Cloud Print. The screen differs depending on the applications or services supporting Google Cloud
Print.

w1

Mew tab

Mew window

Mew in:ggni‘t\o windpw

Bookmarks k

Edit Cut  Copy Paste
Zoom - % - 3 Print

SaVE pAGE 3%

Fird... t # Tetal 1 sheet of pager
Print._, tri~ —
er I | Print | Cancel

Teoks [3

History
Dgwnloads

Destination Print with Google Cloud Print = |

Sign in to Chrame...

Settings
Abaut Google Chrome
Help

Exit

When the preparation for printing with Google Cloud Print is complete and when the machine is turned
on, the machine receives the print data and prints it automatically.

3> Note

» Depending on the communication status, it may take a while to print the print data or the machine
may not receive the print data.

* While printing with Google Cloud Print, the printing may be canceled depending on the machine's
status, such as when the machine is being operated or an error has occurred. To resume printing,
check the machine's status, then print with Google Cloud Print again.

* For print settings:

« If you select the media type other than plain paper or if you select the paper size other than A4/
Letter/B5/A5-size, the print data is printed in single-sided even when you select the duplex print
setting. (* The paper size differs depending on the model of your printer. For information about
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the supported paper sizes, go to the Online Manual home page, and refer to the "Cannot Print
Properly with Automatic Duplex Printing" for your model.)

* If you select plain paper as media type or if you select B5/A5-size as paper size, the print data is
printed with border even when you select the borderless print setting.

» The print results may differ from the print image depending on the print data.

» Depending on the device sending the print data, you may not select the print settings when
sending the print data with Google Cloud Print.

When you want to print from Google Cloud Print immediately

When the machine cannot receive the print data, or you want to start printing immediately, you can check
whether there is a print job on the Google Cloud Print and start printing manually.

Follow the steps below.

22 Important

» Depending on your printer model, this function may not be available.

1. Make sure that the machine is turned on.

2. Display the Home screen.

3. Select m Setup.

4. Select Web service inquiry.

»» Note

« If you have not registered the machine with Google Cloud Print, Web service inquiry is not
displayed.
Register the machine with Google Cloud Print.

5. Select Print from Google Cloud Print.

The confirmation screen to check is displayed.

6. Select Yes.

If there is the print data, the machine receives the print data and prints it.

25



Using Remote Ul

This service allows you to check printer information and execute utility functions from your computer or

smartphone.

You can also use the convenient web services presented by Canon.

Menu
Printer status
Utilities
AirPrint settings
Google Cloud Print setup

Firmware update

Manual ([Online)

Checking the printer IP address

To use this service, first check the IP address of this machine from the operation panel of the machine.

22 Important

» Before you check the IP address of this machine or use the Remote Ul, make sure that the machine
is connected to the LAN and the LAN environment is connected to the Internet. Note that the
customer is responsible for paying all Internet connection fees.

1. Check that the machine has been turned on

If your printer has a LCD monitor

—
2. From the home window, select W Setup -> Device settings -> LAN settings

-> Confirm LAN settings -> WLAN setting list or LAN setting list. Then from the
displayed window, check the IP address.

»» Note

» To print the IP address, load one sheet of A4 size or Letter size plain paper. Then from the

M sa s mes |
m
B —
home window, select Setup -> Device settings -> LAN settings -> Confirm

LAN settings -> Print LAN details, in sequence.
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If your printer does not have a LCD monitor
2. Load one sheet of A4 size or Letter size plain paper
3. Hold down the Stop button until the Alarm lamp flashes 15 times

4. Release the button

Printing of the network setup information starts.

Remote Ul startup

In the Web browser, directly enter the IPv4 address that you checked from the LCD monitor of the
machine. The Remote Ul starts.

1. From your computer, smartphone, or tablet device, open the Web browser, and enter the
following URL:

http:// <Printer IP address>

For "<Printer IP address>" enter the IP address that you checked in "Checking the printer IP address."

2. Remote Ul startup
The Remote Ul starts and the top window is displayed.
Menu
Printer status
Utilities
AirPrint settings
Google Cloud Print setup

Firmware update

Manual (Online)

Printer status
This function displays printer information such as the remaining ink amount, the status, and
detailed error information.
You can also connect to the ink purchase site or support page, and use Web Services.
Utilities
This function allows you to set and execute the machine utility functions such as cleaning.
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AirPrint settings
This function allows you to specify the Apple AirPrint settings, such as position information.

Google Cloud Print setup
This function allows you to register this machine to Google Cloud Print or delete the machine.

Firmware update
This function allows you to update the firmware and check version information.

Manual (Online)
This function displays the Online Manual.

Network Configuration
This function displays the network settings.
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Printing from AirPrint Compliant Device

This document explains how to use AirPrint to print wirelessly from your iPad, iPhone and iPod touch to a
Canon printer.

AirPrint enables you to print photos, email, Web pages and documents from your Apple device directly to
your printer without installing a driver.

AirPrint

Checking Your Environment

First, check your environment.

* AirPrint Operation Environment

To use AirPrint, you will need one of the following Apple devices running the latest version of iOS:

o iPad (all models)
> iPhone (3GS or later)
o iPod touch (3rd generation or later)

¢ Network Environment

The Apple device (iPad, iPhone, or iPod touch) and this machine must be connected to the same Wi-
Fi network.

Printing with AirPrint
1. Check that this machine is turned on and is connected to the LAN.

2. From the app of your Apple device, tap the operation icon to display the menu options.
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4. From Printer Options, select the model that you are using.

2% Important

» Because some app does not support AirPrint, Printer Options may not be displayed. If an app
does not let you use printer options, you cannot print from that app.

1% Note

» The printer options differ depending on the app and model you are using. Normally, when you
tap Print and select a model name, the displayed printer options will include up to the following
four options:

* Printer: Select a model that can be used in your wireless LAN.
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» Copies: Select the number of print copies.

» Duplex Printing: If the model supports duplex printing, you can select On or Off.

* Range: The page range can be used only with specific app and file types (such as PDF
files).

5. For 1 Copy, click + or - to set the number of required copies.
6. For Duplex Printing, click On to enable duplex printing or click Off to disable the function.

7. When printing a file type that has multiple pages, such as a PDF file, click Range and then
click All Pages or select the range of pages to be printed.

8. Tap the Print.

When you execute printing, the printer prints according to the specified settings.

Paper Size

With AirPrint, the paper size is selected automatically according to the app being used on the Apple
device and the region in which AirPrint is used.

When Apple's photo app is used, the default paper size is L size in Japan, and 4"x6" or KG in other
countries and regions.

When documents are printed from Apple's Safari app, the default paper size is letter size in the U.S.
region, and A4 in Japan and Europe.

22 Important

» Your app may support different paper sizes.

Checking the Print Status

During printing, a Print icon is displayed in the list of recently used app, and you can use it to check the
print progress.

To display the list of latest used app, press the Home button on the Apple device twice. The Print icon is
displayed at the bottom of the Home screen.
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Deleting a Print Job

To delete a print job with AirPrint, use one of the following two methods:

» From the machine: If your printer has a LCD monitor, use the operation panel to cancel the print job.
If you printer does not have a LCD monitor, press the Stop button on the machine to cancel the print
job.

» From an Apple device: Press the Home button on the Apple device twice. Tap the Print icon and
display the print job list. Tap the print job to be canceled, and then tap Cancel Print.

AirPrint Troubleshooting

If the document does not print, check the following:

1. Check that the machine power is on. If the machine power is on, turn it off and then back
on again, and check whether the issue is resolved.

2. Check that the machine is connected by LAN to the same network subnet as the device on
which iOS is installed.

3. Check that the machine has enough paper and ink.

4. If your printer has a LCD monitor, check that no error message is displayed on the LCD
monitor.

If the problem persists, use the printer driver on your computer to execute printing and check whether
the document can be printed normally on the machine.

If the document cannot be printed, refer to the Online Manual for your model.
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3> Note

« After you turn on the machine, it may take few minutes before the machine can communicate through
a wireless LAN connection. Confirm that the machine is connected to the wireless LAN, and then try
printing.

« If Bonjour on the machine is disabled, AirPrint cannot be used. Check the LAN settings on the
machine, and enable Bonjour.

> Note

» The windows used in the explanations may differ from those displayed by your Apple product or app.
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How to Use Print from E-mail

Print from E-mail allows you to print attachment files easily. You only attach a picture or a document from
your computer or smartphone and send the e-mail with the attached file.

You can print simply from outside like a travel destination. Also, your family or friends can print by
registering beforehand.

You can use Print from E-mail on any Canon printer that supports the service.

@xx@mp.c—i_i.cum
(7

Checking Your Environment

First, check your environment.

¢ Network environment

This product needs to be connected to a LAN with an Internet connection.

32 Important

» The user will bear the cost of Internet access.
+ This function may not be available in some countries/regions.
» Depending on your printer model, this function may not be available.

* Printer software (firmware) version

If the printer's firmware version is earlier than Ver. 2.000, you need to update the firmware.
You can execute firmware update from Remote Ul or from your printer.

To execute the update from Remote Ul, refer to the Remote Ul usage instructions.

To execute the update from your printer, go to the Online Manual home page, and refer to the
"Firmware Update" document for your printer model.

Preparing to use Print from E-mail

To use Print from E-mail, you need to register the printer by entering information about the printer's
owner.
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1. Print the printer registration page's URL and the PIN code

2. Access the URL and enter the owner's e-mail address and other required information

3. Check if an e-mail has been sent to the e-mail address you entered

4. Access the URL provided in the e-mail and complete the printer registration process

3> Note

» The e-mail address that appears on the screen when you have finished registering is the e-mail
address that will be used just for the Print from E-mail function.

= For details about the reqistration procedure, see here

Printing from Your Computer or Smartphone

1. Prepare a file that you want to print
The file format, number of files, and file size that this printing function supports are provided below.

Supported File Formats

* Adobe PDF files
» JPEG files

2% Important

» Only files that are attached to e-mail can be printed. E-mail messages cannot be printed.

» Encrypted Adobe PDF files, password-protected files, and files that are set to print disabled
cannot be printed.

« Files that are attached as compressed files cannot be printed.

« Files other than Adobe PDF files and JPEG files cannot be printed.

Supported Number of Files and File Sizes

» Up to 10 attachment files can be printed.
¢ The maximum size of an e-mail with attachment files is 5 MB.

»» Note

» The size of an e-mail is determined based on the size of the entire transmission file, including the
e-mail message and the header.
Therefore sometimes an attachment file cannot be printed even if the size of the attachment file
is less than 5 MB.

« If the size of an attached JPEG file is less than 10 KB, the file cannot be printed.

2. Attach a file that you want to print from your PC or smartphone to the e-mail and send it to
the e-mail address for printing

To check the printer address, perform one of the following operations from the operation panel of this
machine:
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» From the operation panel of this machine, display the home window and select m Setup ->

==l Web service setup -> Web service connection setup -> Print from E-mail setup ->
Check address for printing.

» From the operation panel of this machine, select . Web service -> EEE=1 Web service
setup -> Cloud settings -> Print from E-mail setup -> Check address for printing.

3» Important

* You will not be able to use the service during periods when the service is undergoing
maintenance.

Use the Service With More Than One Person

To allow multiple users to use this function, register users (other than the printer's owner) as members.

1. The printer's owner uses his/her PC or smartphone to access the service's login URL
(https://pr.mp.c-ij.com/po) and logs in

2. Select the printer name that you want to add the member. Click Member Settings -> Add
to enter the member's e-mail address, and click Register

A URL of the member registration page is sent to the e-mail address of the newly registered member.

3. Registered member accesses to the URL that is included in the e-mail, and complete the
registration

You can use this service from registered e-mail address.

> Note

* You can register up to 500 members.

Print from E-mail Troubleshooting

= The Document Does Not Print
= |f You Cannot Register to the Service or Delete the Service
= |f You Cannot Print after the Printer Is Repaired

The Document Does Not Print

If the document does not print, check the following:

» Check that the printer power is on.
If the printer power is on, turn it off and then back on again, and check whether the issue is resolved.
» Check that the printer is connected to the network.
» Check that the printer is connected to a LAN and the LAN has an Internet connection.
» Look at the printer LCD monitor and check that no error message is displayed.
If the problem persists, use the printer driver on your computer to execute printing and check whether

36



the document can be printed normally on the printer.
If the document cannot be printed, refer to the on-screen manual (operating instructions) that comes
with the printer.

» Check that the file attached to the e-mail is a Adobe PDF file or an JPEG file.

* Check whether the e-mail address of the send destination is correct.
To check the printer address, perform one of the following operations from the operation panel of this
machine:

o From the operation panel of this machine, display the home window and select W Setup ->

=il Web service setup -> Web service connection setup -> Print from E-mail setup ->
Check address for printing.

o From the operation panel of this machine, select . Web service -> EEE=1 Web service
setup -> Cloud settings -> Print from E-mail setup -> Check address for printing.

» Check that the user's e-mail address for using this service is registered.
If you want to check the error details, the printer owner have to access the login URL (https://pr.mp.c-
ij.com/po).

* In the Print Status screen, click Go to Print History Screen and check the history of jobs that were
sent. You can check the error details.
If you want to check the error details, the printer owner have to access the login URL (https://pr.mp.c-
ij.com/po).

»» Note

» For a wireless LAN connection, after the printer is turned on, it may take a few minutes before
communication becomes possible. Confirm that your printer is connected to the wireless LAN, and
then try printing.

If You Cannot Register to the Service or Delete the Service

If You Cannot Register to the Service

« If the printer operation panel display the message "Failed to register with "Print from E-mail".", the
registration to Print from E-mail may not have been completed in time. Select OK to release the
error, and start over again from the beginning.

» Check that the firmware version of the printer has been updated.

If You Do Not Receive the URL to Complete the Registration by E-mail

* An incorrect e-mail address may have been entered. Wait about 30 minutes, and operate the printer
operation panel to print the printer registration URL and PIN code. Then re-register from the
beginning.

If You Cannot Delete the Service

« If the printer operation panel display the message "Failed to connect to "Print from E-mail". Only the
information on the printer was deleted." is displayed, it could be that the registration information on the
service could not be deleted even though the Print from E-mail information stored on this machine
was deleted.

Select OK to release the error, and then access the service's login URL (https://pr.mp.c-ij.com/po) to
delete the registration information.
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« If the Print from E-mail information stored on this printer could not be deleted even though the
registration information on the service was deleted, delete the registration information from
Deregistration of Registered Printer(s) by performing one of the following operations:

o From the operation panel of this machine, display the home window and select W Setup ->

=il Web service setup -> Web service connection setup -> Print from E-mail setup ->
Deregistration of Registered Printer(s).

o From the operation panel of this machine, select . Web service -> EEE=1 Web service
setup -> Cloud settings -> Print from E-mail setup -> Deregistration of Registered
Printer(s).

If You Cannot Print after the Printer Is Repaired

Re-registering the printer and the printer owner

* When the printer is repaired, all of the registered information is deleted and Print from E-mail can no
longer be used.
If you want to use this service again, you must re-register the printer and the printer owner.
For information about the re-registration procedure, see "Preparing to Use Print from E-mail".
Even if users other than the owner were registered as members, repeat the registration starting from
here.

Trademarks

» Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

» Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or
other countries.

» Mac OS, Bonjour, iPad, iPhone, iPod touch, and Safari are trademarks of Apple Inc., registered in the
U.S. and other countries. AirPrint and the AirPrint logo are trademarks of Apple Inc.

* 10S is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

* All other company names and products mentioned herein may be trademarks or registered
trademarks of their respective companies.
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Preparing to Use Print from E-mail

To use this service to print a photo or document, you need to follow the procedure provided below and
register the machine.

Print the Printer Registration Page's URL and the PIN Code

First, print the printer registration page's URL and the PIN code.
Check that there is sufficient amount of ink in the machine, and then print using the machine's operation
panel.

1. Check that the machine is connected to the network

2% Important

» This product needs to be connected to a LAN with an Internet connection.

2. From the operation panel of this machine, display the home page and select Register
printer by performing one of the following operations:

» From the operation panel of this machine, display the home window and select m Setup ->

==l Web service setup -> Web service connection setup -> Print from E-mail setup ->
Register printer.

» From the operation panel of this machine, display the home window and select . Web

service -> M Web service setup -> Cloud settings -> Print from E-mail setup ->
Register printer.

3. Follow the instructions on the screen and print the printer registration URL and PIN code

2% Important

* Do not turn off the power on the machine until the registration process is completed.
Access the printed URL and log in within 25 minutes.

* If you canceled the registration before it is completed, repeat the procedure from printing the
registration information.

Access the Printed URL and Enter the Owner's E-mail Address and Other
Required Information

Next, enter the owner's e-mail address and other required information.
1. Access the printed URL using the PC's web browser, and click Log In

2. In the use agreement window, select Agree
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2% Important

* If you do not select Agree in the use agreement window, you will not able to register as the
printer owner.

3. Enter the printer owner's e-mail address, and click Next

2% Important

* An e-mail is sent with the required information for completing the registration to the e-mail
address entered for the printer's owner.

« If domain-specific reception is set, change the setting so that mail can be received from
"info@mp.c-ij.com"

»» Note

* The e-mail address of the printer owner cannot be changed once the printer owner is registered.
To change the e-mail address, delete the registration of the registered printer, and re-register the
printer owner by using the new e-mail address. In this case, all previously registered information
will be deleted.

» The notification is sent automatically to the registered e-mail address when the printing or service

maintenance starts.

4. In the Printer Owner Registration window, enter the information shown below, and click
Next

User Name

Enter any name.
The name that you enter is displayed at login.

2% Important

« The maximum number of characters that can be entered is 30.

Language

Select the language that you are using.

The language that you select is used in notification e-mails such as print start notices.
Time Zone

Refer to this section, and select the standard time of the city that is nearest to the region where you live.

Date/Time Display Format

Select the format of your choice. The format that you select is applied to the date/time information in the
screens and notification e-mails of this service.

Daylight Saving Time

This setting is combined with the Time Zone setting, and applied to the date/time information in the
screens and notification e-mails of this service.

When you select ON, 1 hour is added to the Time Zone setting when the date/time information is
displayed.

5. In the Printer Registration window, enter the Printer Name, and click Confirm
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Enter any name that will allow you to identify the printer.

2% Important

* The maximum number of characters that can be entered is 30.

6. In the Confirm Owner Registration window, check the registration information, and then
click Register
A temporary password will be displayed.

2% Important

» The temporary password that appears is not included in the notification e-mail. Be sure to write
down the temporary password before closing the screen.

Check if an E-mail Has Been Sent to the E-mail Address You Entered

A URL is notified to complete the registration to the e-mail address that for the registered printer's owner.

Access the URL in the E-mail and Complete the Printer Registration

1. Access the URL provided in the e-mail

2% Important

* You have to complete the registration within 30 minutes.

2. Enter the registered e-mail address of the printer's owner, the temporary password, and

click Log In

3. Set a password of your choice, and click Register

When the password setting process is completed, the printer's e-mail address and the service's URL
are displayed, and the printer's registration process is completed.

2% Important

» When you enter the password, the following character restrictions apply.

+ Set a password that has 8 or more characters.

» The characters that you can use are single-byte uppercase letters, single-byte lowercase
letters, and single-byte numbers.

+ In the password, combine all of the different types of characters that can be used.

» The displayed printer's e-mail address and the URL of the login page are not sent. Be sure to
write down the printer's e-mail address and the URL of the login page before closing the screen.
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Timezone List

(UTC-12:00) | International Date Line West

(UTC-11:00) | Midway Island

(UTC-10:00) | Hawaii

(UTC-09:00) | Alaska

(UTC-08:00) | Tijuana, Baja California, Pacific Time (US & Canada)

(UTC-07:00) | Arizona, Chihuahua, La Paz, Mazatlan, Mountain Time (US & Canada)

(UTC-06:00) | Guadalajara, Mexico City, Monterrey, Saskatchewan, Central America, Central Time (US & Canada)
(UTC-05:00) | Indiana (East), Bogota, Lima, Quito, Eastern Time (US & Canada), Caracas

(UTC-04:00) | Asuncion, Santiago, Georgetown, La Paz, San Juan, Manaus, Atlantic Time (Canada), Newfoundland
(UTC-03:00) | Cayenne, Greenland, Buenos Aires, Brasilia, Montevideo

(UTC-02:00) | Mid-Atlantic

(UTC-01:00) | Azores, Cape Verde Is.

(UTC+00:00)

Casablanca, Dublin, Edinburgh, Lisbon, London, Monrovia, Reykjavik, Coordinated Universal Time

(UTC+01:00)

Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna, Sarajevo, Skopje, Warsaw, Zagreb, Brussels,
Copenhagen, Madrid, Paris, Belgrade, Bratislava, Budapest, Ljubljana, Prague, West Central Africa

(UTC+02:00)

Athens, Bucharest, Istanbul, Amman, Windhoek, Jerusalem, Cairo, Harare, Pretoria, Beirut, Helsinki,
Kyiv, Riga, Sofia, Tallinn, Vilnius, Minsk

(UTC+03:00)

Kuwait, Riyadh, Thilisi, Nairobi, Baghdad, Moscow, St. Petersburg, Volgograd, Tehran

(UTC+04:00)

Abu Dhabi, Muscat, Yerevan, Baku, Port Louis, Kabul

(UTC+05:00)

Islamabad, Karachi, Ekaterinburg, Tashkent, Sri Jayawardenepura, Chennai, Kolkata, Mumbai, New
Delhi, Kathmandu

(UTC+06:00)

Astana, Dhaka, Almaty, Novosibirsk, Yangon (Rangoon)

(UTC+07:00)

Krasnoyarsk, Bangkok, Hanoi, Jakarta

(UTC+08:00)

Irkutsk, Ulaan Bataar, Kuala Lumpur, Singapore, Perth, Taipei, Beijing, Chongqing, Hong Kong, Urumqi

(UTC+09:00)

Seoul, Yakutsk, Osaka, Sapporo, Tokyo, Adelaide, Darwin

(UTC+10:00)

Vladivostok, Canberra, Melbourne, Sydney, Guam, Port Moresby, Brisbane, Hobart

(UTC+11:00)

Magadan, Solomon Is., New Caledonia

(UTC+12:00)

Auckland, Wellington, Fiji, Marshall Is., Petropavlovsk-Kamchatsky

(UTC+13:00)

Samoa, Nuku'alofa
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Overview of the Machine

»

3

Safety Guide
= Safety Precautions

= Regulatory and Safety Information

Main Components and Basic Operations
= Main Components
= About the Power Supply of the Machine

Loading Paper / Originals

= | oading Paper
= | oading Originals

Replacing a FINE Cartridge
= Replacing a FINE Cartridge
= Checking the Ink Status

Maintenance

= \When Printing Becomes Faint or Colors Are Incorrect
= Performing Maintenance from a Computer

= Cleaning the Machine

Changing the Machine Settings
= Changing Machine Settings from Your Computer
= Changing the Machine Settings Using the Operation Panel

Information about Network Connection
= Useful Information about Network Connection

About Network Communication

= Changing and Confirming Network Settings

= Screens for Network Connection of |J Network Tool
= Other Screens of |J Network Tool

= Appendix for Network Communication

Tips for Ensuring Optimal Printing Quality

Useful Information about Ink

Key Points to Successful Printing

Be Sure to Make Paper Settings after Loading Paper
Canceling a Print Job

Key to Enjoying Consistent Printing Quality

= Precautions for Safe Transport of the Machine

4

(=
=
(=
=

Legal Limitations on Use of Your Product and Use of Images
Specifications
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Safety Guide

“ Safety Precautions

“ Regulatory and Safety Information
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Safety Precautions

Choosing a location

Do not install the machine in a location that is unstable or subject to excessive vibration.

Do not install the machine in locations that are very humid or dusty, in direct sunlight, outdoors, or close to a
heating source.

To avoid the risk of fire or electric shocks, use the machine under the operating environment specified in the
On-screen Manual.

Do not place the machine on a thick rug or carpet.

Do not place the machine with its back attached to the wall.

Power supply

Ensure that the area around the power outlet is kept clear at all times so you can easily unplug the power cord
if necessary.

Never remove the plug by pulling on the cord.

Pulling the cord may damage the power cord, leading to possible fire or electrical shock.

Do not use an extension lead/cord.

Working around the machine

Never put your hands or fingers in the machine while it is printing.

When moving the machine, carry the machine at both ends. In case the machine weighs more than 14 kg, it is
recommended to have two people lifting the machine. Accidental dropping of the machine causes injury. For
the machine's weight, refer to the On-screen Manual.

Do not place any object on the machine. Especially do not place metal objects (paper clips, staples, etc.) or
containers of flammable solvents (alcohol, thinners, etc.) on top of the machine.

Do not transport or use the machine on a slant, vertically or upside-down, as the ink may leak and damage the
machine.

Working around the machine (For the multifunction printer)

When loading a thick book on the Platen Glass, do not press hard on the Document Cover. The Platen Glass
may break and cause injury.

Print Heads/ink tanks and FINE Cartridges

Keep ink tanks out of the reach of children. In case ink* is accidentally licked or swallowed, rinse out mouth or
give one or two glasses of water to drink. If irritation or discomfort occurs, obtain medical advice immediately.
* Clear Ink contains nitrate salts (For models containing Clear Ink).

In case ink gets in contact with eyes, rinse with water immediately. In case ink gets in contact with skin, wash
with soap and water immediately. If irritation to eyes or skin persists, obtain medical advice immediately.
Never touch the electrical contacts on a Print Head or FINE Cartridges after printing.

The metal parts may be very hot and could cause burns.

Do not throw ink tanks and FINE Cartridges into fire.

Do not attempt to disassemble or modify the Print Head, ink tanks, and FINE Cartridges.
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Regulatory and Safety Information

International ENERGY STAR® Program

As an ENERGY STAR Partner, Canon Inc. has determined that this product meets the
ENERGY STAR guidelines for efficiency.

3)

ENERGY STAR

About the disposal of the battery (For models containing
lithium battery)

Dispose of used batteries according to the local regulations.

Users in the U.S.A.

FCC Notice (U.S.A. Only)
For 120V, 60Hz model
Model Number: K10393

This device complies with Part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) This device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired
operation.

Note: This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio
communications.

However, there is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is encouraged to try to correct
the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.

Use of a shielded cable is required to comply with Class B limits in Subpart B of Part 15 of
the FCC Rules.
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Do not make any changes or modifications to the equipment unless otherwise specified in
the manual. If such changes or modifications should be made, you could be required to stop
operation of the equipment.

Contains FCC approved WLAN module

Changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate equipment.

This transmitter must not be co-located or operating in conjunction with any other antenna
or transmitter.

The equipment complies with FCC radiation exposure limits for at uncontrolled equipment.
This equipment should be installed and operated with minimum distance at least 20cm
between the radiator and persons body (excluding extremities: hands, wrists, feet and
ankles) and must not be colocated or operated with any other antenna or transmitter.

Canon U.S.A,, Inc.

One Canon Park
Melville, New York 11747
1-800-652-2666

Users in Canada

This device complies with Industry Canada license-exempt RSS standard(s). Operation is
subject to the following two conditions:

(1) this device may not cause interference, and (2) this device must accept any
interference, including interference that may cause undesired operation of the device.

This equipment complies with IC radiation exposure limits set forth for an uncontrolled
environment and meets RSS-102 of the IC radio frequency (RF) Exposure rules. This
equipment should be installed and operated keeping the radiator at least 20cm or more
away from person's body (excluding extremities: hands, wrists, feet and ankles).

Pour les usagers résidant au Canada

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils
radio exempts de licence.

L'exploitation est autorisée aux deux conditions suivantes :

(1) l'appareil ne doit pas produire de brouillage, et (2) I'utilisateur de I'appareil doit accepter
tout brouillage radioélectrique subi, méme si le brouillage est susceptible d'en
compromettre le fonctionnement.
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Cet équipement est conforme aux limites d'exposition aux rayonnements énoncées pour un
environnement non contrélé et respecte les régles d'exposition aux fréquences
radioélectriques (RF) CNR-102 de I'IC. Cet équipement doit étre installé et utilisé en
gardant une distance de 20 cm ou plus entre le dispositif rayonnant et le corps (a
I'exception des extrémités : mains, poignets, pieds et chevilles).

Users in Jordan

This printer contains WLAN Module (K30356) approved by TRC/SS/2013/36 or WLAN
Module (K30357) approved by TRC/LPD/2013/130

European Union (and EEA) only.

X

This symbol indicates that this product is not to be disposed of with your household waste,
according to the WEEE Directive (2002/96/EC) and your national law. This product should
be handed over to a designated collection point, e.g., on an authorized one-for-one basis
when you buy a new similar product or to an authorized collection site for recycling waste
electrical and electronic equipment (EEE). Improper handling of this type of waste could
have a possible negative impact on the environment and human health due to potentially
hazardous substances that are generally associated with EEE. At the same time, your
cooperation in the correct disposal of this product will contribute to the effective usage of
natural resources. For more information about where you can drop off your waste
equipment for recycling, please contact your local city office, waste authority, approved
WEEE scheme or your household waste disposal service. For more information regarding
return and recycling of WEEE products, please visit www.canon-europe.com/environment.

(EEA: Norway, Iceland and Liechtenstein)

India only.

)i¢

This product is not to be disposed of with your household waste, according to the e-waste
(Management and Handling) Rules, 2011.

This product should be handed over to a designated collection point, e.g., to an authorized
collection site for recycling waste electrical and electronic equipment (EEE). Improper
handling of this type of waste could have a possible negative impact on the environment
and human health due to potentially hazardous substances that are generally associated
with EEE. At the same time, your cooperation in the correct disposal of this product will
contribute to the effective usage of natural resources. For more information regarding return
and recycling of WEEE products, please visit http://www.canon.co.in/environment/.
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Also, this product complies with the "India E-waste Rule 2011" and prohibits use of lead,
mercury, hexavalent chromium, polybrominated biphenyls or polybrominated diphenyl
ethers in concentrations exceeding 0.1 % by weight and 0.01 % by weight for Cadmium,
except for the exemptions set in Schedule Il of the Rule.

Environmental Information

Reducing your environmental impact while saving money

Power Consumption and Activation Time

The amount of electricity a device consumes depends on the way the device is used. This
product is designed and set in a way to allow you to reduce your electricity costs. After the
last print it switches to Ready Mode. In this mode it can print again immediately if required.
If the product is not used for a time, the device switches to its Power Save Mode. The
devices consume less power (Watt) in these modes.

If you wish to set a longer Activation Time or would like to completely deactivate the Power
Save Mode, please consider that this device may then only switch to a lower energy level
after a longer period of time or not at all.

Canon does not recommend extending the Activation Times from the optimum ones set as
default.

Energy Star®

The Energy Star® programme is a voluntary scheme to promote the development and
purchase of energy efficient models, which help to minimise environmental impact.

Products which meet the stringent requirements of the Energy Star® programme for both
environmental benefits and the amount of energy consumption will carry the Energy Star®
logo accordingly.

Paper types

This product can be used to print on both recycled and virgin paper (certified to an
environmental stewardship scheme), which complies with EN12281 or a similar quality

standard. In addition it can support printing on media down to a weight of 64g/m2, lighter
paper means less resources used and a lower environmental footprint for your printing
needs.

C€
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Main Components and Basic Operations

* Main Components

“ About the Power Supply of the Machine
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Main Components

® Front View
* Rear View
* Inside View

“ Operation Panel
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Front View

(1) (2) (3) (4)

(1) paper output support
Extend to support ejected paper.

(2) paper output tray
Printed paper is ejected.

(3) paper output cover
Open to replace the FINE cartridge or remove jammed paper inside the machine.

(4) document cover
Open to load an original on the platen glass.

(5) paper guides
Slide to align with both sides of the paper stack.

(6) front tray
Load various sizes or types of paper which you can use on the machine. Two or
more sheets of the same size and type of paper can be loaded at the same time,
and fed automatically one sheet at a time.

= |_oading Plain Paper / Photo Paper

= | oading Envelopes

(7) front cover
Open to load paper in the front tray.

(8) paper support

Extend to load paper in the front tray.
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(9) output tray extension
Open to support ejected paper.

(10) (1)

(10) operation panel
Use to change the settings of the machine or to operate it.

= Operation Panel

(11) platen glass
Load an original to copy or scan.
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Rear View

(1)

(1) transport unit
Open to remove jammed paper.

(2) power cord connector
Plug in the supplied power cord.
(3) USB port
Plug in the USB cable to connect the machine with a computer.

»» Important

= Do not touch the metal casing.
= Do not plug in or unplug the USB cable while the machine is printing or scanning
originals with the computer.
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Inside View

(1) ink cartridge lock lever
Locks the FINE cartridge into place.
(2) FINE cartridge (ink cartridges)
A replaceable cartridge that integrates print head and ink tank.
(3) FINE cartridge holder
Install the FINE cartridge.
The color FINE cartridge should be installed into the left slot and the black FINE

cartridge should be installed into the right slot.

(4) head cover

Opens to enable replacement of the FINE cartridge. The head cover will open
automatically when you open the paper output cover.

13 Note

= For details on replacing a FINE cartridge, see Replacing a FINE Cartridge.

» Important

= The area around the parts (A) may be splattered with ink. This does not affect the
performance of the machine.

= Do not touch the parts (A) or the electrical contacts (B) behind them. The machine
may not print properly if you touch them.
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(B)
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Operation Panel

* The Wi-Fi and Alarm lamps are shown lit in the illustration below for explanatory
purposes.

(1)

(2)
(3)

(11) = (4

(5)

— e L)

(7)

(8)

(1) ON lamp

Lights green after flashing when the power is turned on.

» Note

ON and Alarm lamps
= You can check the status of the machine by the ON and Alarm lamps.

— ON lamp is off: The power is off.

— ON lamp lights green: The machine is ready to print.

— ON lamp flashes green: The machine is getting ready to print, or printing is in
progress.

— Alarm lamp flashes orange: An error has occurred and the machine is not ready
to print.

= "Support Code Corresponding to the Number of Flashes of the Alarm Lamp" in If

an Error Occurs

— ON lamp flashes green and Alarm lamp flashes orange alternately: An error that
requires contacting the service center may have occurred.

= "Support Code Corresponding to the Number of Alternate Flashes of the ON

Lamp and the Alarm Lamp" in If an Error Occurs

(2) ON button

Turns the power on or off. Before turning on the power, make sure that the
document cover is closed.
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= Turning the Machine On and Off

(3) Wi-Fi lamp
Lights or flashes blue to indicate the wireless LAN status.
Lights:

Wireless LAN connection is enabled.
Flashes:

Printing or scanning over wireless LAN. Also flashes while configuring the wireless
LAN connection.

(4) Wi-Fi button

Hold down to automatically set up the wireless LAN connection.
(5) ink lamps

Light or flash orange when ink runs out, etc.

The left lamp indicates the color FINE cartridge status, the right lamp the black FINE
cartridge status.

(6) Paper button
Selects the page size and media type.
(7) Paper lamp
Lights to indicate the page size and media type selected with the Paper button.

(8) Stop button

Cancels operations. You can press this button to cancel a print, copy, or scan job in
progress. Holding this button down lets you select maintenance options or machine
settings.

(9) Color button*

Starts color copying. You can also press this button to finalize your selection for the
setting item.

(10) Black button*

Starts black & white copying. You can also press this button to finalize your selection
for the setting item.

(11) Alarm lamp
Lights or flashes orange when an error occurs, such as paper-out or ink-out. When
performing machine maintenance or machine settings, options can be selected
according to the number of flashes.

* In the software applications or manuals, the Color and Black buttons are collectively
called the "Start" or "OK" button.
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About the Power Supply of the Machine

® Confirming that the Power Is On
* Turning the Machine On and Off
* Notice for the Power Plug/Power Cord

“ Notice for Unplugging the Power Cord
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Confirming that the Power Is On

The ON lamp is lit green when the machine is turned on.

13 Note

= |t may take a while for the machine to start printing immediately after you turn on the
machine.
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Turning the Machine On and Off

Turning on the machine

1. Press the ON button to turn on the machine.

The ON lamp flashes and then remains lit green.

= Confirming that the Power Is On

23 Note

= It may take a while for the machine to start printing immediately after you turn on the
machine.
= If the Alarm lamp lights up or flashes orange, see If an Error Occurs.

Auto power on feature
= You can set the machine to automatically turn on when a print or scan operation is
performed from a computer connected by USB cable or wireless network. This
feature is set to off by default.
= Managing the Machine Power

Turning off the machine

1. Press the ON button to turn off the machine.

When the ON lamp stops flashing, the machine is turned off.
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»» Important

When you unplug the power cord after turning off the machine, be sure to confirm
that the ON lamp is off.
= Notice for Unplugging the Power Cord

» Note

Auto power off feature
You can set the machine to automatically turn off when no operations are performed
or no print jobs are sent to the machine for a certain interval. This is the default
setting.
= Managing the Machine Power
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Notice for the Power Plug/Power Cord

Unplug the power cord once a month to confirm that the power plug/power cord does not
have anything unusual described below.

@« The power plug/power cord is hot.

@« The power plug/power cord is rusty.

@« The power plug/power cord is bent.

« The power plug/power cord is worn.

@« The power plug/power cord is split.

Ay Caution

If you find anything unusual with the power plug/power cord described above, unplug
the power cord and call for service. Using the machine with one of the unusual
conditions above may cause a fire or an electric shock.

= Notice for Unplugging the Power Cord
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Notice for Unplugging the Power Cord

To unplug the power cord, follow the procedure below.
»» Important

= When you unplug the power cord, press the ON button, then confirm that the ON lamp
is off. Unplugging the power cord while the ON lamp is lit or flashing may cause drying
or clogging of the print head and print quality may be reduced.

1. Press the ON button to turn the machine off.

2. Confirm that the ON lamp is off.

3. Unplug the power cord.
%‘h\

The specification of the power cord differs depending on the country or region of use.
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Loading Paper / Originals

® Loading Paper

* Loading Originals
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Loading Paper

® Loading Plain Paper / Photo Paper
* Loading Envelopes

* Media Types You Can Use

“ Media Types You Cannot Use

® Printing Area
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Loading Plain Paper / Photo Paper

You can load plain paper or photo paper.
»» Important

If you cut plain paper into small size such as 4" x 6" (10 x 15 cm) or 5" x 7" (13 x 18 cm)
to perform trial print, it can cause paper jams.

»» Note

We recommend Canon genuine photo paper for printing photos.

For details on the Canon genuine paper, see Media Types You Can Use.

You can use general copy paper.

For the page size and paper weight you can use for this machine, see Media Types You
Can Use.

1. Prepare paper.

Align the edges of paper. If paper is curled, flatten it.

» Note

Align the edges of paper neatly before loading. Loading paper without aligning the
edges may cause paper jams.

If paper is curled, hold the curled corners and gently bend them in the opposite
direction until the paper becomes completely flat.

For details on how to flatten curled paper, see "Load the paper after correcting its
curl." in Paper Is Smudged/Printed Surface Is Scratched.

When using Photo Paper Plus Semi-gloss SG-201, even if the sheet is curled, load
one sheet at a time as it is. If you roll up this paper to flatten, this may cause cracks
on the surface of the paper and reduce the print quality.

2. Load paper.

(1) Open the front cover gently, and extend the paper support.
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=

(2) Use the right paper guide (A) to slide both paper guides all the way out.

(3) Load the paper in the center of the front tray WITH THE PRINT SIDE

FACING DOWN.
Push the paper stack all the way to the back of the front tray.

-

(A)

(4) Slide the right paper guide (A) to align the paper guides with both sides
of the paper stack.
Do not slide the paper guides too hard against the paper. The paper may not be fed
properly.

» Important

= Always load paper in the portrait orientation (B). Loading paper in the landscape
orientation (C) can cause paper jams.
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(B) (C)

23» Note

= Do not overload paper by stacking until the top of the stack touches the paper
guides.

= Load small size paper, such as 4" x 6" (10 x 15 cm), by pushing it in all the way
to the back of the front tray.

(5) Open the output tray extension.

3. Open the paper output tray.
(1) Open the paper output tray gently, and extend the paper output support.
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»» Important

= Be sure to open the paper output tray when printing. If not open, the machine
cannot start printing.

13 Note

After loading paper
= Select the size and type of the loaded paper on the print settings screen of the
operation panel or printer driver.
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Loading Envelopes

You can load Envelope DL and Envelope Com 10.
The address is automatically rotated and printed according to the envelope's direction by

specifying with the printer driver properly.
»» Important

Printing of envelopes from the operation panel is not supported.

Do not use the following envelopes. They could jam in the machine or cause the
machine to malfunction.

- Envelopes with an embossed or treated surface

- Envelopes with a double flap
- Envelopes whose gummed flaps are already moistened and adhesive

1. Prepare envelopes.

@ Press down on all four corners and edges of the envelopes to flatten them.

« If the envelopes are curled, hold the opposite corners and gently twist them in the

opposite direction.

« If the corner of the envelope flap is folded, flatten it.
#» Use a pen to press the leading edge in the inserting direction flat and sharpen the
crease.

The figures above show a side view of the leading edge of the envelope.

»» Important

The envelopes may jam in the machine if they are not flat or the edges are not
aligned. Make sure that no curl or puff exceeds 0.1 inches (3 mm).

2. Load envelopes.

71



(1) Open the front cover gently, and extend the paper support.

Gt

(2) Use the right paper guide (A) to slide both paper guides all the way out.

(3) Load the envelopes in the center of the front tray WITH THE ADDRESS
SIDE FACING DOWN.

The folded flap of the envelope will be faced up on the left side.

(B) (C)
(B) Rear side
(C) Address side

Push the envelopes all the way to the back of the front tray.

Up to 5 envelopes can be loaded at once.

(A)

(4) Slide the right paper guide (A) to align the paper guides with both sides
of the envelopes.

Do not slide the paper guides too hard against the envelopes. The envelopes may
not be fed properly.
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oy (A)

13» Note

= Do not overload envelopes by stacking until the top of the stack touches the
paper guides.

(5) Open the output tray extension.

3. Open the paper output tray.
(1) Open the paper output tray gently, and extend the paper output support.

» Important

= Be sure to open the paper output tray when printing. If not open, the machine
cannot start printing.

73



»» Note

After loading envelopes
Select the size and type of the loaded envelopes on the print settings screen of the
printer driver.
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Media Types You Can Use

Choose paper suitable for printing, for the best print results. Canon provides you various
types of paper to enhance the fun of printing, such as stickers as well as papers for photo or
document. We recommend the use of Canon genuine paper for printing your important
photos.

Media Types

Commercially available papers
« Plain Paper (including recycled paper)™! "2
« Envelopes

Canon genuine papers

The Model Number of Canon genuine paper is shown in brackets. Refer to the instruction
manual supplied with the paper for detailed information on the printable side and notes on
handling paper. For information on the page sizes available for each Canon genuine paper,
access our website.

»» Note

You may not be able to purchase some Canon genuine papers depending on the
country or region of purchase. Paper is not sold in the US by Model Number. Purchase
paper by name.

Paper for printing photos:
« Photo Paper Pro Platinum <PT-101>

« Glossy Photo Paper "Everyday Use" <GP-501/GP-601>"2
« Photo Paper Glossy <GP-601>2

« Photo Paper Plus Glossy Il <PP-201>"2

« Photo Paper Pro Luster <LU-101>"2

« Photo Paper Plus Semi-gloss <SG-201>"2
« Matte Photo Paper <MP-101>
Paper for printing business documents:
« High Resolution Paper <HR-101N>
Paper for creating your own prints:

« T-Shirt Transfers <TR-301>
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« Photo Stickers <PS-101>

*1 100% recycled paper can be used.

*2 This paper is also available for making copies. Select with the Paper button on the
operation panel. You can select only A4 or Letter-sized plain paper or 4" x 6" (10 x 15 cm)
photo paper.

= Paper Load Limit
= Setting the Media Type with the Printer Driver

Page Sizes
You can use the following page sizes.

» Note

Only the following sizes may be printed from the operation panel.
- A4, Letter, and 4" x 6" (10 x 15 cm)

Standard sizes:

@ Letter @ Legal

@ A5 « A4

« B5 @« 4"x6" (10x 15 cm)
@« 5"x7"(13x 18 cm) @« 8"x 10" (20 x 25 cm)
« Envelope DL « Envelope Com 10

Non-standard sizes:

You can print on non-standard size paper within the following ranges.
@ Minimum size: 3.50 x 5.00 inches (89.0 x 127.0 mm)
@« Maximum size: 8.50 x 26.61 inches (215.9 x 676.0 mm)

Paper Weight
You can use paper in the following weight range.

@ 17 to 28 Ib (64 to 105 g /m?2) (except for Canon genuine paper)
Do not use heavier or lighter paper (except for Canon genuine paper), as it could jam in the
machine.

Notes on Storing Paper

« Take out only the necessary number of paper from the package, just before printing.
« To avoid curling, when you do not print, put unused paper back into the package and
keep it on a level surface. And also, store it avoiding heat, humidity, and direct sunlight.
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Paper Load Limit

Commercially Available Papers

Media Name Front Tray Paper Output Tray
|Plain Paper (including recycled paper)’! Approx. 100 sheets Approx. 50 sheets
|Enve|opes 5 envelopes "2

Canon Genuine Papers

»» Note

We recommend that you remove the previously printed sheet from the paper output tray
before continuously printing to avoid blurs and discoloration (except for High Resolution
Paper <HR-101N>).

Paper for printing photos:

Media Name <Model No.> Front Tray
10 sheets: A4, Letter, and 8" x 10" (20 x 25
[Photo Paper Pro Platinum <PT-101>"3 cm)
20 sheets: 4" x 6" (10 x 15 cm)
Glossy Photo Paper "Everyday Use" 10 sheets: A4 and Letter
<GP-501/GP-601>"3 20 sheets: 4" x 6" (10 x 15 cm)

10 sheets: A4 and Letter
20 sheets: 4" x 6" (10 x 15 cm)
10 sheets: A4, Letter, 5" x 7" (13 x 18 cm),

[Photo Paper Plus Glossy Il <PP-201>"3 and 8" x 10" (20 x 25 cm)
20 sheets: 4" x 6" (10 x 15 cm)

[Photo Paper Glossy <GP-601>"3

[Photo Paper Pro Luster <LU-101>"3 10 sheets: A4 and Letter

10 sheets: A4, Letter, 5" x 7" (13 x 18 cm),

[Photo Paper Plus Semi-gloss <SG-201>3  [and 8" x 10" (20 x 25 cm)
00 sheets: 4" x 6" (10 x 15 cm)

10 sheets: A4 and Letter

[Matte Photo Paper <MP-101>
20 sheets: 4" x 6" (10 x 15 cm)

Paper for printing business documents:

Media Name <Model No.> Front Tray Paper Output Tray

|High Resolution Paper <HR-101N> 80 sheets 50 sheets
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Paper for creating your own prints:

Media Name <Model No.> Front Tray
T-Shirt Transfers <TR-301> 1 sheet
Photo Stickers <PS-101> 1 sheet

*1 Proper feeding of paper may not be possible at the maximum capacity depending on the
type of paper or environmental conditions (either very high or low temperature or humidity).
In such cases, reduce the number of paper you load at a time to less than half.

*2 We recommend that you remove the previously printed envelope from the paper output
tray before continuously printing to avoid blurs and discoloration.

*3 When loading paper in stacks, the print side may become marked as it is fed or paper
may not feed properly. In this case, load one sheet at a time.
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Media Types You Cannot Use

Do not use the following types of paper. Using such paper will cause not only unsatisfactory
results, but also the machine to jam or malfunction.
« Folded, curled, or wrinkled paper
« Damp paper
@ Paper that is too thin (weighing less than 17 Ib (64 g /m?))
@ Paper that is too thick (weighing more than 28 Ib (105 g /m2), except for Canon genuine
paper)
@« Paper thinner than a postcard, including plain paper or notepad paper cut to a small
size (when printing on paper smaller than A5)

t.

Picture postcards

t.

Postcards affixed with photos or stickers

t.

Envelopes with a double flap

t.

Envelopes with an embossed or treated surface

t.

Envelopes whose gummed flaps are already moistened and adhesive

t.

Any type of paper with holes

t.

Paper that is not rectangular

t.

Paper bound with staples or glue

t.

Paper with adhesives

t.

Paper decorated with glitter, etc.
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Printing Area

® Printing Area
® Other Sizes than Letter, Legal, Envelopes
® Letter, Legal

“ Envelopes
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Printing Area

To ensure the best print quality, the machine allows a margin along each edge of media.
The actual printable area will be the area inside these margins.

Recommended printing area Bl : Canon recommends that you print within this area.
Printable area 1 : The area where it is possible to print.

However, printing in this area can affect the print quality or the paper feed precision.

»» Note

With performing Automatic Duplex Printing, the printable area will be 0.08 inches (2
mm) smaller at the top margin.

Borderless Printing
By selecting Borderless Printing option, you can make prints with no margins.

When performing Borderless Printing, slight cropping may occur at the edges since the

printed image is enlarged to fill the whole page.

For Borderless Printing, use the following paper:

- Photo Paper Pro Platinum <PT-101>

- Glossy Photo Paper "Everyday Use" <GP-501/GP-601>

- Photo Paper Glossy <GP-601>

- Photo Paper Plus Glossy Il <PP-201>

- Photo Paper Pro Luster <LU-101>

- Photo Paper Plus Semi-gloss <SG-201>

- Matte Photo Paper <MP-101>

Performing Borderless Printing on any other type of paper may substantially reduce
printing quality and/or result in printouts with altered color hues.

Borderless Printing on plain paper may result in printouts with reduced quality. Use

them only for test printing. Borderless Printing onto plain paper from the operation panel

is not supported.
Borderless Printing is not available for legal, A5, or B5 sized paper, or envelopes.

Depending on the type of paper, Borderless Printing may reduce the print quality at the

top and bottom edges of the paper or cause these parts to become smudged.
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Other Sizes than Letter, Legal, Envelopes

Size Printable Area (width x height)
AS 5.56 x 7.95 inches (141.2 x 202.0 mm)
A4 8.00 x 11.38 inches (203.2 x 289.0 mm)
[B5 6.90 x 9.80 inches (175.2 x 249.0 mm)

4" x 6" (10 x 15 cm)

3.73 x 5.69 inches (94.8 x 144.4 mm)

5" x 7" (13 x 18 cm)

4.73 x 6.69 inches (120.2 x 169.8 mm)

8" x 10" (20 x 25 cm)

7.73 x 9.69 inches (196.4 x 246.0 mm)

I -
© - (A)

Il Recommended printing area

(A) 1.28 inches (32.5 mm)
(B) 1.32 inches (33.5 mm)

[ Printable area

(C) 0.12 inches (3.0 mm)
(D) 0.20 inches (5.0 mm)
(E) 0.13 inches (3.4 mm)
(F) 0.13 inches (3.4 mm)
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Letter, Legal

Size Printable Area (width x height)
|Letter 8.00 x 10.69 inches (203.2 x 271.4 mm)
|Lega| “8.00 x 13.69 inches (203.2 x 347.6 mm)
5 .. r
‘ }'1. = :’A}

(D) J:: [, 8)
ML i

(E) (F)

L

I Recommended printing area

(A) 1.28 inches (32.5 mm)
(B) 1.32 inches (33.5 mm)

1 Printable area

(C) 0.12 inches (3.0 mm)
(D) 0.20 inches (5.0 mm)
(E) 0.25 inches (6.4 mm)
(F) 0.25 inches (6.3 mm)
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Envelopes

Size

Recommended Printing Area (width x height)

|Enve|ope DL

3.88 x 7.06 inches (98.8 x 179.5 mm)

|Enve|ope Com 10

3.68 x 7.90 inches (93.5 x 200.8 mm)

(A) ::'. a

@17

Wt
-

(€) (D)

Bl Recommended printing area

(A) 0.31 inches (8.0 mm)
(B) 1.28 inches (32.5 mm)
(C) 0.22 inches (5.6 mm)
(D) 0.22 inches (5.6 mm)

~ A~ A~ o~
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Loading Originals

® Loading Originals on the Platen Glass
® Originals You Can Load

* How to Detach / Attach the Document Cover
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Loading Originals on the Platen Glass

You can load originals to copy or scan on the platen glass.

1. Load an original on the platen glass.

(1) Open the document cover.

(2) Load the original WITH THE SIDE TO SCAN FACING DOWN on the

platen glass.
= Originals You Can Load

Align the corner of the original with the alignment mark .

(1)

(2)

»» Important

Be sure to observe the following when loading the original on the platen glass.

- Do not place any objects weighing 4.4 Ib (2.0 kg) or more on the platen glass.

- Do not put any pressure of 4.4 |b (2.0 kg) or more on the platen glass, such as
pressing down the original.

Failure to observe the above may cause the scanner to malfunction or the platen

glass to break.
The machine cannot scan the shaded area (A) (0.04 inches (1 mm) from the edges

of the platen glass).
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2. Close the document cover gently.

»» Important

= After loading the original on the platen glass, be sure to close the document cover
before starting to copy or scan.
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Originals You Can Load

The originals you can load on the platen glass are as follows.

Item Details
- Text document, magazine, or newspaper
Types of originals - Printed photo, postcard, business card, or disc
(BD/DVD/CD, etc.)
Size (width x height) Max. 8.5 x 11.7 inches (216 x 297 mm)

»» Note

When loading a thick original such as a book on the platen glass, you can load it by
removing the document cover from the machine.
= How to Detach / Attach the Document Cover
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How to Detach / Attach the Document Cover

Detaching the document cover:
Hold up the document cover vertically and then pull it up.

D
Attaching the document cover:

Fit both hinges (A) of the document cover into the holder (B) and insert both hinges of the
document cover vertically as illustrated below.

<
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Replacing a FINE Cartridge

® Replacing a FINE Cartridge
® Checking the Ink Status
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Replacing a FINE Cartridge

When remaining ink cautions or errors occur, the ink lamps and the Alarm lamp will flash
orange to inform you of the error. Count the number of flashes and take appropriate action.
= |f an Error Occurs

» Note

For information on the compatible FINE cartridge, refer to the printed manual: Safety
and Important Information.

Replacing Procedure
When you need to replace a FINE cartridge, follow the procedure below.
= \Watch the movie

»» Important

Handling FINE cartridge
Do not touch the electrical contacts (A) or print head nozzle (B) on a FINE cartridge.

The machine may not print properly if you touch them.

(A)

(B)

If you remove a FINE cartridge, replace it immediately. Do not leave the machine with
the FINE cartridge removed.

Use a new FINE cartridge for replacement. Installing a used FINE cartridge may cause
the nozzles to clog.

Furthermore, with such a FINE cartridge, the machine will not be able to inform you
when to replace the FINE cartridge properly.

Once a FINE cartridge has been installed, do not remove it from the machine and leave
it out in the open. This will cause the FINE cartridge to dry out, and the machine may
not operate properly when it is reinstalled. To maintain optimal printing quality, use a
FINE cartridge within six months of first use.

»» Note

If a FINE cartridge runs out of ink, you can print with either color or black FINE
cartridge, in whichever ink remains, only for a while. However the print quality may be
reduced compared to when printing with both cartridges. We recommend to use a new
FINE cartridge in order to obtain optimum qualities.
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Even when printing with one ink only, print with leaving the empty FINE cartridge
installed. If either of the color FINE cartridge or black FINE cartridge is not installed, an
error occurs and the machine cannot print.
For information on how to configure this setting, see Setting the Ink Cartridge to be
Used.

= Color ink may be consumed even when printing a black-and-white document or when
black-and-white printing is specified.
Both color ink and black ink are also consumed in the standard cleaning and deep
cleaning of the print head, which may be necessary to maintain the performance of the
machine. When ink runs out, replace the FINE cartridge immediately with a new one.
= Useful Information about Ink

1. Make sure that the power is turned on, open the front cover (C), then
open the paper output tray (D).

(D)

(C)

2. Open the paper output cover (E).

When the FINE cartridge holder moves to the replacement position, the head cover (F)
OPENS AUTOMATICALLY.

(E) (F}

/& Caution

= Do not hold the FINE cartridge holder to stop or move it forcibly. Do not touch the
FINE cartridge holder until it stops completely.
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»» Important

= The head cover will open automatically after you open the paper output cover.
If you have closed the head cover while replacing a FINE cartridge, close the paper
output cover, then open it again.
Trying to force open the head cover with your hand may cause the machine to
malfunction.

= Do not touch the metallic parts or other parts inside the machine.

= If the paper output cover is left open for more than 10 minutes, the FINE cartridge
holder moves to the far right and the Alarm lamp lights. In this case, close the paper
output cover, then open it again.

3. Remove the empty FINE cartridge.

(1) Push down the ink cartridge lock lever until it clicks.

»» Important

= Handle the FINE cartridge carefully to avoid staining of clothing or the surrounding

area.
= Discard the empty FINE cartridge according to the local laws and regulations
regarding disposal of consumables.
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4. Prepare a new FINE cartridge.

(1) Take a new FINE cartridge out of its package and remove the protective
tape (G) gently.

»» Important

= If you shake a FINE cartridge, ink may spill out and stain your hands and the
surrounding area. Handle a FINE cartridge carefully.

= Be careful not to stain your hands and the surrounding area with ink on the removed
protective tape.

= Do not reattach the protective tape once you have removed it. Discard it according
to the local laws and regulations regarding disposal of consumables.

= Do not touch the electrical contacts or print head nozzle on a FINE cartridge. The
machine may not print properly if you touch them.

5. Install the FINE cartridge.

(1) Insert the new FINE cartridge straight into the FINE cartridge holder all
the way until it touches the back.

The color FINE cartridge should be installed into the left slot and the black FINE
cartridge should be installed into the right slot.
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»» Important

= Insert the FINE cartridge gently so that it does not hit the electrical contacts on
the FINE cartridge holder.

(2) Push up the ink cartridge lock lever to lock the FINE cartridge into

place.
The FINE cartridge is locked into place when the ink cartridge lock lever clicks.

»» Important

= Check if the FINE cartridge is installed correctly.
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= The machine cannot print unless both the color FINE cartridge and black FINE
cartridge are installed. Be sure to install both cartridges.

6. Close the paper output cover (H).

(H)

» Note

= |f the Alarm lamp lights or flashes orange after the paper output cover is closed,
take appropriate action.
= |f an Error Occurs

= When you start printing after replacing the FINE cartridge, the machine starts
cleaning the print head automatically. Do not perform any other operations until the
machine completes the cleaning of the print head.

= If the print head is out of alignment, as indicated by misaligned printed ruled lines or
similar symptoms, adjust the print head position.
= Aligning the Print Head

= The machine may make noise during operation.
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Checking the Ink Status

“ Checking the Ink Status with the Ink Lamps on the Operation Panel

You can also check the ink status on the computer screen.
“ Checking the Ink Status from Your Computer
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Checking the Ink Status with the Ink Lamps on the
Operation Panel

»» Note

The ink level detector is mounted on the machine to detect the remaining ink level. The
machine considers as ink is full when a new FINE cartridge is installed, and then starts
to detect a remaining ink level. If you install a used FINE cartridge, the indicated ink
level of it may not be correct. In such case, refer to the ink level information only as a
guide.

When remaining ink cautions or errors occur, the ink lamps and the Alarm lamp will
flash orange to inform you of the error. Count the number of flashes and take
appropriate action.

= |f an Error Occurs

In the copy standby mode, you can check the ink status with the Color Ink lamp and Black
Ink lamp.

* All the lamps on the operation panel are shown lit in the illustration below for explanatory
purposes.

(A)

(B) (C)

(A) Alarm lamp
(B) Color Ink lamp
(C) Black Ink lamp

Color Ink lamp or Black Ink lamp lights

The ink is running low. Prepare a new ink cartridge.

Color Ink lamp or Black Ink lamp flashes, while Alarm lamp flashes

An error has occurred.
= |f an Error Occurs
* For some types of errors, the Alarm lamp may not flash.

»» Note

You can also check the ink status on the computer screen.

98



= Checking the Ink Status from Your Computer
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Maintenance

= \Vhen Printing Becomes Faint or Colors Are Incorrect
= Performing Maintenance from a Computer
= Cleaning the Machine
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When Printing Becomes Faint or Colors Are Incorrect

® Maintenance Procedure

® Printing the Nozzle Check Pattern

“ Examining the Nozzle Check Pattern
“ Cleaning the Print Head

® Cleaning the Print Head Deeply

“ Aligning the Print Head
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Maintenance Procedure

If print results are blurred or colors are not printed correctly, the print head nozzle (FINE
cartridge) is probably clogged. Follow the procedure below to print the nozzle check pattern,
check the print head nozzle condition, then clean the print head.
If printed ruled lines are misaligned or print results are otherwise unsatisfactory, aligning the
print head may improve print quality.

»» Important

Do not rinse or wipe the FINE cartridge. This can cause trouble with the FINE cartridge.

»» Note

Before performing maintenance
Check if ink remains in the FINE cartridge.
= Checking the Ink Status with the Ink Lamps on the Operation Panel
Check if the FINE cartridge is installed correctly.
= Replacing Procedure
Also check if the protective tape on the bottom of the FINE cartridge is removed.

If the Alarm lamp lights or flashes orange, see If an Error Occurs.
Increasing the print quality in the printer driver settings may improve the print result.
= Changing the Print Quality and Correcting Image Data
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When the Print Results Are Blurred or Uneven:
Step 1

Print the nozzle check pattern.

From the machine

= Printing the Nozzle Check Pattern

From the computer

= Use Your Computer to Print a Nozzle Check
Pattern

Examine the nozzle check pattern.

After cleaning the print head,
print and examine the nozzle
check pattern.

= Examining the Nozzle Check Pattern
If there are missing lines or horizontal white
streaks in the pattern:

"'v'
Step 2
Clean the print head.

From the machine
= Cleaning the Print Head
From the computer
= Cleaning the Print Heads from Your
Computer
If the problem is not resolved after cleaning the
print head twice:

“"v"
Step 3
Clean the print head deeply.

From the machine
= Cleaning the Print Head Deeply
From the computer
= Cleaning the Print Heads from Your
Computer
If the problem is not resolved, turn off the power
and clean the print head deeply again after 24
hours.

If the problem is still not resolved:

g
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Step 4

Replace a FINE cartridge.
= Replacing a FINE Cartridge

»» Note

If the problem is still not resolved after replacing the FINE cartridge, contact the service

center.

When the Print Results Are Not Even such as the Ruled Lines
Are Misaligned:
Align the print head.

From the machine

= Aligning the Print Head

From the computer

= Aligning the Print Head Position Automatically from Your Computer
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Printing the Nozzle Check Pattern

Print the nozzle check pattern to determine whether the ink ejects properly from the print
head nozzle.
= \Vatch the movie

» Note

If the remaining ink level is low, the nozzle check pattern will not be printed correctly.
Replace the FINE cartridge whose ink is low.
= Replacing a FINE Cartridge

You need to prepare: a sheet of A4 or Letter-sized plain paper
1. Make sure that the power is turned on.
2. Load a sheet of A4 or Letter-sized plain paper in the front tray.

3. Open the output tray extension, open the paper output tray, then extend
the paper output support.

4. Hold down the Stop button until the Alarm lamp flashes orange once,
then release it immediately.

The nozzle check pattern will be printed.
Do not perform any other operations until the machine completes the printing of the
nozzle check pattern.

5. Examine the nozzle check pattern.

= Examining the Nozzle Check Pattern
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Examining the Nozzle Check Pattern

Examine the nozzle check pattern, and clean the print head if necessary.

1. Check if there are missing lines in the pattern (A) or horizontal white
streaks in the pattern (B).

- | T —

(B)

— 8 F N F
1 u 4 m (5] [ £
- .

(C) Number of sheets printed so far

If there are missing lines in the pattern (A):
Cleaning the print head is required.

= Cleaning the Print Head
o) (E)

(D) Good
(E) Bad (lines are missing)

If there are horizontal white streaks in the pattern (B):
Cleaning the print head is required.

= Cleaning the Print Head

(F) (G)

(F) Good
(G) Bad (horizontal white streaks are present)

»» Note

The total number of sheets printed so far is shown in increments of 50 sheets on the
printout of the nozzle check pattern.
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Cleaning the Print Head

Clean the print head if lines are missing or if horizontal white streaks are present in the
printed nozzle check pattern. Cleaning unclogs the nozzles and restores the print head
condition. Cleaning the print head consumes ink, so clean the print head only when
necessary.

1. Make sure that the power is turned on.

2. Hold down the Stop button until the Alarm lamp flashes orange twice,
then release it immediately.

The machine starts cleaning the print head.
The cleaning will be complete when the ON lamp lights green after flashing.

Do not perform any other operations until the machine completes the cleaning of the
print head. This takes about 1 to 2 minutes.

3. Check the print head condition.

To check the print head condition, print the nozzle check pattern.
= Printing the Nozzle Check Pattern

»» Note

If the problem is not resolved after cleaning the print head twice, clean the print head
deeply.
= Cleaning the Print Head Deeply
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Cleaning the Print Head Deeply

If print quality does not improve by the standard cleaning of the print head, clean the print
head deeply. Cleaning the print head deeply consumes more ink than the standard cleaning
of the print head, so clean the print head deeply only when necessary.

1. Make sure that the power is turned on.

2. Hold down the Stop button until the Alarm lamp flashes orange three
times, then release it immediately.

The machine starts cleaning the print head deeply.
The cleaning will be complete when the ON lamp lights green after flashing.

Do not perform any other operations until the machine completes the deep cleaning of
the print head. This takes about 1 to 2 minutes.

3. Check the print head condition.

To check the print head condition, print the nozzle check pattern.

= Printing the Nozzle Check Pattern

If the problem is not resolved, turn off the power and clean the print head deeply again after
24 hours.

If the problem is still not resolved, replace the FINE cartridge with a new one.
= Replacing a FINE Cartridge

If the problem is still not resolved after replacing the FINE cartridge, contact the service

center.

108



Aligning the Print Head

If printed ruled lines are misaligned or print results are otherwise unsatisfactory, adjust the
print head position.

» Note

If the remaining ink level is low, the print head alignment sheet will not be printed
correctly. Replace the FINE cartridge whose ink is low.
= Replacing a FINE Cartridge

You need to prepare: a sheet of A4 or Letter-sized plain paper (including
recycled paper)*

* Be sure to use paper that is white and clean on both sides.
1. Make sure that the power is turned on.
2. Load a sheet of A4 or Letter-sized plain paper in the front tray.

3. Open the output tray extension, open the paper output tray, then extend
the paper output support.

4. Hold down the Stop button until the Alarm lamp flashes orange four
times, then release it immediately.

The print head alignment sheet will be printed.
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»» Important

Do not touch any printed part on the print head alignment sheet.

Be careful not to get the print head alignment sheet dirty. If the sheet is stained
or wrinkled, it may not be scanned properly.

If the print head alignment sheet was not printed correctly, press the Stop
button, then redo this procedure from the beginning.

5. Scan the print head alignment sheet to adjust the print head position.

(1) Load the print head alignment sheet on the platen glass.
Load the print head alignment sheet WITH THE PRINTED SIDE FACING DOWN
and align the mark « on the bottom right corner of the sheet with the alignment
mark &1,
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(2) Close the document cover gently, then press the Color button or the
Black button.
The machine starts scanning the print head alignment sheet, and the print head
position will be adjusted automatically.
The print head position adjustment will be complete when the ON lamp lights green
after flashing.
Remove the print head alignment sheet on the platen glass.

»» Important

Do not open the document cover or move the print head alignment sheet on the
platen glass until adjusting the print head position is complete.

If adjusting the print head position has failed, the Alarm lamp flashes orange.
Press the Stop button to release the error, then take appropriate action.

= |f an Error Occurs

»» Note

If the print results are still not satisfactory after adjusting the print head position as
described above, adjust the print head position manually from the computer.

= Aligning the Print Head Position from Your Computer

To print and check the current head position adjustment values, hold down the Stop
button until the Alarm lamp flashes orange six times, then release it immediately.
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Performing Maintenance from a Computer

@ Cleaning the Print Heads from Your Computer

@ Cleaning the Paper Feed Rollers from Your Computer

@ Aligning the Print Head

@ Aligning the Print Head Position Automatically from Your Computer
@ Aligning the Print Head Position from Your Computer

@ Use Your Computer to Print a Nozzle Check Pattern

@ Cleaning Inside the Machine
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Cleaning the Print Heads from Your Computer

The print head cleaning function allows you to clear up clogged print head nozzle. Perform

print head cleaning if printing is faint or a specific color fails to print, even though there is
enough ink.

The procedure for cleaning the print head is as follows:

e
S Cleaning

1. Open the printer driver setup window

2. Click Cleaning on the Maintenance tab
When the Print Head Cleaning dialog box opens, select the ink group for which
cleaning is to be performed.
Click Initial Check Items to display the items you need to check before performing
cleaning.

3. Execute cleaning
Make sure that the machine is on and then click Execute.
Print head cleaning starts.

4. Complete cleaning
The Nozzle Check dialog box opens after the confirmation message.

5. Check the results
To check whether the print quality has improved, click Print Check Pattern. To
cancel the check process, click Cancel.
If cleaning the head once does not resolve the print head problem, clean it once
more.

»» Important

Cleaning consumes a small amount of ink.

Cleaning the print head frequently will rapidly deplete your printer's ink supply.
Consequently, perform cleaning only when necessary.
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)
M Deep Cleaning

Deep Cleaning is more thorough than cleaning. Perform deep cleaning when two Cleaning
attempts do not resolve the print head problem.

1. Open the printer driver setup window

2. Click Deep Cleaning on the Maintenance tab
When the Deep Cleaning dialog box opens, select the ink group for which deep
cleaning is to be performed.
Click Initial Check Items to display the items you need to check before performing
deep cleaning.

3. Execute deep cleaning
Make sure that the machine is on and then click Execute.
Click OK when the confirmation message appears.
Print head deep cleaning starts.

4. Complete deep cleaning
The Nozzle Check dialog box opens after the confirmation message.

5. Check the results
To check whether the print quality has improved, click Print Check Pattern. To
cancel the check process, click Cancel.

»» Important

Deep Cleaning consumes a larger amount of ink than Cleaning.

Cleaning the print head frequently will rapidly deplete your printer's ink supply.
Consequently, perform cleaning only when necessary.

»» Note

If there is no sign of improvement after Deep Cleaning, switch off the machine, wait

24 hours, and then perform Deep Cleaning again. If there is still no sign of
improvement, see "Ink Is Not Ejected."

Related Topic

@ Use Your Computer to Print a Nozzle Check Pattern

114



Cleaning the Paper Feed Rollers from Your Computer

Cleans the paper feed rollers. Perform feed roller cleaning when there are paper particles
sticking to the paper feed rollers and paper is not fed properly.

The procedure for performing the feed roller cleaning is as follows:

Roller Cleaning

1. Prepare the machine

Remove all sheets of paper from the front tray.

2. Open the printer driver setup window

3. Click Roller Cleaning on the Maintenance tab

The confirmation message appears.

4. Execute paper feed roller cleaning

Make sure that the machine is on and then click OK.
Paper feed roller cleaning starts.

5. Complete paper feed roller cleaning

After the rollers have stopped, follow the message instructions and load one sheet of
plain paper or a cleaning sheet available on the market into the front tray. Then click
OK.

Paper will be ejected and feed roller cleaning will be completed.
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Aligning the Print Head

When you perform head position adjustment, errors in the print head adjustment position
are corrected and conditions such as color and line streaking are improved.

If the print results appear uneven because of line shifts or other conditions, adjust the
position of the print head.

On this machine, you can adjust the print head either automatically or manually.
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Aligning the Print Head Position from Your Computer

Print head alignment corrects the installation positions of the print head and improves
deviated colors and lines.

This machine supports two head alignment methods: automatic head alignment and manual
head alignment.

The procedure for performing manual print head alignment is as follows:

Print Head Alignment
1. Open the printer driver setup window

2. Click Custom Settings on the Maintenance tab

The Custom Settings dialog box opens.

3. Switch head alignment to manual

Check the Align heads manually check box.

4. Apply the settings

Click OK and when the confirmation message appears, click OK.

5. Click Print Head Alignment on the Maintenance tab

The Start Print Head Alignment dialog box opens.

6. Load paper in the machine

Load three sheets of A4 size or Letter size plain paper into the front tray.

7. Execute head alignment

Make sure that the machine is on and click Align Print Head.
Follow the instruction in the message.

8. Check the printed pattern

Enter the numbers of the patterns with the least amount of streaks in the associated
boxes.

Even if the patterns with the least amount of streaks are clicked in the preview
window, their numbers are automatically entered in the associated boxes.
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When you have entered all the necessary values, click OK.

»» Note

If it is difficult to pick the best pattern, pick the setting that produces the least
noticeable vertical streaks.

(A) (B)
(A) Least noticeable vertical streaks
(B) Most noticeable vertical streaks
If it is difficult to pick the best pattern, pick the setting that produces the least
noticeable horizontal streaks.

(A) (B)

(A) Least noticeable horizontal streaks
(B) Most noticeable horizontal streaks

9. Confirm the displayed message and click OK

10.

The second pattern is printed.

Check the printed pattern

Enter the numbers of the patterns with the least amount of streaks in the associated
boxes.

Even if the patterns with the least amount of streaks are clicked in the preview
window, their numbers are automatically entered in the associated boxes.
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When you have entered all the necessary values, click OK.

»» Note

If it is difficult to pick the best pattern, pick the setting that produces the least
noticeable vertical streaks.

(A) (B)
(A) Least noticeable vertical streaks
(B) Most noticeable vertical streaks

11. Confirm the displayed message and click OK
The third pattern is printed.

12. Check the printed pattern

Enter the numbers of the patterns with the least noticeable horizontal stripes in the
associated boxes.

Even if the patterns with the least noticeable horizontal stripes are clicked in the
preview window, their numbers are automatically entered in the associated boxes.
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When you have entered all the necessary values, click OK.

»» Note

If it is difficult to pick the best pattern, pick the setting that produces the least
noticeable horizontal stripes.

(A) (B)
(A) Least noticeable horizontal stripes
(B) Most noticeable horizontal stripes

»» Note

To print and check the current setting, open the Start Print Head Alignment dialog
box, and click Print Alignment Value.
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Aligning the Print Head Position Automatically from
Your Computer

Print head alignment corrects the installation positions of the print head and improves
deviated colors and lines.

This machine supports two head alignment methods: automatic head alignment and manual
head alignment. Normally, the machine is set for automatic head alignment. If the printing
results of automatic print head alignment are not satisfactory, perform manual head
alignment.

The procedure for performing automatic print head alignment is as follows:

Print Head Alighment

. Open the printer driver setup window

-_—

2. Click Print Head Alignment on the Maintenance tab

The Start Print Head Alignment dialog box opens.

3. Load paper in the machine

Load one sheet of A4 size or Letter size plain paper into the front tray.

»» Note

The number of sheets to be used differs when you select the manual head
alignment.

4. Print head alignment pattern printing

Make sure that the machine is on and click Align Print Head.
The adjustment pattern is printed.

»» Important

Do not open the paper output cover while printing is in progress.

5. Adjustment pattern scanning

After the adjustment pattern is printed, a message is displayed.

As instructed in the message, load the adjustment pattern onto the platen, and press
the Start button on the machine.

Print head alignment starts.
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»» Note

To print and check the current setting, open the Start Print Head Alignment dialog
box, and click Print Alignment Value.
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Use Your Computer to Print a Nozzle Check Pattern

The nozzle check function allows you to check whether the print head is working properly
by printing a nozzle check pattern. Print the pattern if printing becomes faint, or if a specific
color fails to print.

The procedure for printing a nozzle check pattern is as follows:

@ Nozzle Check

. Open the printer driver setup window

-_—

2. Click Nozzle Check on the Maintenance tab

The Nozzle Check dialog box opens.
Click Initial Check Items to display the items that you need to check before printing
the nozzle check pattern.

3. Load paper in the machine

Load one sheet of A4 size or Letter size plain paper into the front tray.

4. Print a nozzle check pattern

Make sure that the machine is on and click Print Check Pattern.
Printing of the nozzle check pattern begins.

Click OK when the confirmation message appears.
The Pattern Check dialog box opens.

5. Check the print result

Check the print result. When the print result is normal, click Exit.

If the print result is smudged or if there are any unprinted sections, click Cleaning to
clean the print head.

Related Topic

@ Cleaning the Print Heads from Your Computer
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Cleaning Inside the Machine

Perform bottom plate cleaning before you execute duplex printing to prevent smudges on
the back side of the paper.

Also perform bottom plate cleaning if ink smudges caused by something other than print
data appear on the printed page.

The procedure for performing bottom plate cleaning is as follows:

Bottom Plate Cleaning
1. Open the printer driver setup window

2. Click Bottom Plate Cleaning on the Maintenance tab

The Bottom Plate Cleaning dialog box opens.

3. Load paper in the machine

As instructed in the dialog box, fold the A4 size or Letter size plain paper in half
horizontally, and then unfold the sheet.

Fold one side of the paper in another half, aligning the edge with the center crease,
then unfold the paper.

With the ridges of the creases facing up, load the paper into the front tray, so that the
edge of the half with no crease faces away from you.

4. Perform the bottom plate cleaning

Make sure that the machine is on and then click Execute.
Bottom plate cleaning starts.
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Cleaning the Machine

® Cleaning the Exterior of the Machine

® Cleaning the Platen Glass and Document Cover

® Cleaning the Paper Feed Roller

“ Cleaning the Inside of the Machine (Bottom Plate Cleaning)

® Cleaning the Protrusions inside the Machine
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Cleaning the Exterior of the Machine

Be sure to use a soft and dry cloth such as eyeglasses cleaning cloth and wipe off dirt on
the surface gently. Smooth out wrinkles on the cloth if necessary before cleaning.

»» Important

Be sure to turn off the power and disconnect the power plug before cleaning the
machine.

Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for
cleaning so as not to scratch the surface. Be sure to use a soft and dry cloth.

Never use volatile liquids such as thinners, benzene, acetone, or any other chemical
cleaner to clean the machine, as this may cause a malfunction or damage the surface
of the machine.
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Cleaning the Platen Glass and Document Cover

»» Important

= Be sure to turn off the power and disconnect the power plug before cleaning the
machine.

= Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for
cleaning so as not to scratch the surface. Be sure to use a soft and dry cloth.

= Never use volatile liquids such as thinners, benzene, acetone, or any other chemical
cleaner to clean the machine, as this may cause a malfunction or damage the surface
of the machine.

With a soft, clean, lint-free and dry cloth, wipe the platen glass (A) and the inner side of the
document cover (white sheet) (B) gently. Make sure not to leave any residue, especially on
the glass surface.

(B)

»» Important

= The inner side of the document cover (white sheet) (B) is easily damaged, so wipe it
gently.
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Cleaning the Paper Feed Roller

If the paper feed roller is dirty or paper powder is attached to it, paper may not be fed

properly.
In this case, clean the paper feed roller. Cleaning will wear out the paper feed roller, so
perform this only when necessary.

You need to prepare: a sheet of A4 or Letter-sized plain paper or
commercially available cleaning sheet

1. Make sure that the power is turned on and remove any paper from the
front tray.

2. Clean the paper feed roller without paper.

(1) Hold down the Stop button until the Alarm lamp flashes orange seven

times, then release it immediately.
The paper feed roller will rotate as it is cleaned.

3. Clean the paper feed roller with paper.

(1) Make sure that the paper feed roller has stopped rotating, load a sheet
of A4 or Letter-sized plain paper or commercially available cleaning
sheet in the front tray.

(2) Open the output tray extension, open the paper output tray, then extend
the paper output support.

(3) Hold down the Stop button until the Alarm lamp flashes orange seven

times, then release it immediately.
The machine starts cleaning. The cleaning will be complete when the paper is
ejected.

If the problem is not resolved after cleaning the paper feed roller, contact the service center.
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Cleaning the Inside of the Machine (Bottom Plate
Cleaning)

Remove stains from the inside of the machine. If the inside of the machine becomes dirty,
printed paper may get dirty, so we recommend performing cleaning regularly.

You need to prepare: a sheet of A4 or Letter-sized plain paper*

* Be sure to use a new piece of paper.

1. Make sure that the power is turned on and remove any paper from the

front tray.

2. Prepare paper.

(1) Fold a single sheet of A4 or Letter-sized plain paper in half widthwise,
then unfold the paper.

(2) Fold one side of the opened paper in another half, aligning the edge
with the center crease, then unfold the paper.

(3) Load only this sheet of paper in the front tray with the ridges of the
creases facing up and the edge of the half with no crease facing away
from you.
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3. Open the output tray extension, open the paper output tray, then extend
the paper output support.

4. Clean the inside of the machine.
Hold down the Stop button until the Alarm lamp flashes orange eight times, then
release it immediately.
The paper cleans the inside of the machine as it feeds through the machine.

Check the folded parts of the ejected paper. If they are smudged with ink, perform
Bottom Plate Cleaning again.

If the problem is not resolved after performing cleaning again, the protrusions inside the
machine may be stained. Clean them according to instructions.
= Cleaning the Protrusions inside the Machine

»» Note

When performing Bottom Plate Cleaning again, be sure to use a new piece of paper.
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Cleaning the Protrusions inside the Machine

»» Important

= Be sure to turn off the power and disconnect the power plug before cleaning the
machine.

You need to prepare: cotton swab

If the protrusions inside the machine are stained, wipe off any ink from the protrusions using
a cotton swab or the like.
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Changing the Machine Settings

= Changing Machine Settings from Your Computer
= Changing the Machine Settings Using the Operation Panel
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Changing Machine Settings from Your Computer

Changing the Print Options

Registering a Frequently Used Printing Profile
Setting the Ink Cartridge to be Used
Managing the Machine Power

Reducing the Machine Noise

Changing the Machine Operation Mode
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Changing the Print Options

You can change the detailed print driver settings for print data that is sent from an
application software.

Specify this option if you encounter print failures such as part of an image data being cut
off.

The procedure for changing the print options is as follows:
1. Open the printer driver setup window

2. Click Print Options... on the Page Setup tab
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2»» Note

= When you use the XPS printer driver, the functions available to you are
different.
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3. Change the individual settings

If necessary, change the setting of each item, and then click OK.

The Page Setup tab is displayed again.
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Registering a Frequently Used Printing Profile

You can register the frequently used printing profile to Commonly Used Settings on the
Quick Setup tab. Unnecessary printing profiles can be deleted at any time.

The procedure for registering a printing profile is as follows:

Registering a Printing Profile
1. Open the printer driver setup window

2. Set the necessary items

From Commonly Used Settings on the Quick Setup tab, select the printing profile
to be used and if necessary, change the settings after Additional Features.
You can also register necessary items on the Main and Page Setup tabs.

3. Click Save...
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The Save Commonly Used Settings dialog box opens.
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4. Save the settings

136



Enter a name in the Name field. If necessary, click Options..., set the items, and
then click OK.

In the Save Commonly Used Settings dialog box, click OK to save the print settings
and return to the Quick Setup tab.

The name and icon are displayed in Commonly Used Settings.

»» Important

To save the page size, orientation, and number of copies that was set in each sheet,
click Options..., and check each item.

»» Note

When you install the printer driver again or upgrade the version of the printer driver,
the print settings you registered will be deleted from Commonly Used Settings.
Registered print settings cannot be saved and preserved. If a profile is deleted, register
the print settings again.

Deleting Unnecessary Printing Profile

1. Select the printing profile to be deleted

Select the printing profile you want to delete from the Commonly Used Settings list
on the Quick Setup tab.

2. Delete the printing profile

Click Delete. When the confirmation message appears, click OK.
The selected printing profile is deleted from the Commonly Used Settings list.

»» Note

Printing profiles that are registered in the initial settings cannot be deleted.

137



Setting the Ink Cartridge to be Used

This feature enables you to specify the most appropriate FINE cartridge among installed
cartridges according to an intended use.

When one of the FINE cartridges becomes empty and cannot be replaced immediately by a
new one, you can specify the other FINE cartridge that still has ink and continue printing.

The procedure for specifying the FINE cartridge is as follows:

@ Ink Cartridge Settings

1. Open the printer driver setup window

2. Click Ink Cartridge Settings on the Maintenance tab
The Ink Cartridge Settings dialog box appears.

3. Select the FINE cartridge to be used

Select the FINE cartridge to be used for printing and click OK.
The specified FINE cartridge will be used from the next printing.

»» Important

When the following settings are specified, Black Only does not function because the
machine uses the color FINE cartridge to print documents.
Other than Plain Paper, Envelope, Hagaki A, or Hagaki is selected for Media Type
on the Main tab
Borderless is selected from the Page Layout list on the Page Setup tab
Do not detach the FINE cartridge that is not in use. Printing cannot be performed while
either FINE cartridge is detached.

138



Managing the Machine Power

This function allows you to manage the machine power from the printer driver.

The procedure for managing the machine power is as follows:

@ Power Off

The Power Off function turns off the machine. When you use this function, you will not be
able to turn the machine on from the printer driver.

1. Open the printer driver setup window

2. Execute power off

Click Power Off on the Maintenance tab. When the confirmation message appears,
click OK.

The machine power switches off, and the Maintenance tab is displayed again.

‘©

Auto Power allows you to set Auto Power On and Auto Power Off.

Auto Power

The Auto Power On function automatically turns on the machine when data is received.
The Auto Power Off function automatically turns off the machine when there are no
operations from the printer driver or the machine for a specified period of time.

1. Open the printer driver setup window

2. Make sure that the machine is on and then click Auto Power on the
Maintenance tab

The Auto Power Settings dialog box opens.

»» Note

If the machine is off or if communication between the machine and the computer
is disabled, an error message may appear because the computer cannot collect
the machine status.

If this happens, click OK to display the most recent settings specified on your
computer.
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3. If necessary, complete the following settings:

Auto Power On
Specifying Enable from the list will turn the machine on upon receipt of print data.

Auto Power Off
Specify the time from the list. When this time lapses without any operations from the
printer driver or the machine, the machine is turned off automatically.

4. Apply the settings

Click OK. When the confirmation message appears, click OK.
The Maintenance tab is displayed again.

The auto power on/off function is enabled hereafter. When you want to disable this
function, select Disable from the list according to the same procedure.

»» Note

When the machine is turned off, the status monitor message varies depending on the
Auto Power On setting.
When the setting is Enable, "Printer is standing by" is displayed. When the setting is
Disable, "Printer is offline" is displayed.

»» Important

If you connect this machine to a network and use it, you can set Auto Power Off but
the power will not switch off automatically.
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Reducing the Machine Noise

The silent function allows you to reduce the operating noise of this machine. Select when
you wish to reduce the operating noise of the printer at night, etc.
Using this function may lower the print speed.

The procedure for using the quiet mode is as follows:

@ Quiet Settings

1. Open the printer driver setup window

2. Click Quiet Settings on the Maintenance tab
The Quiet Settings dialog box opens.

»» Note

If the machine is off or if communication between the machine and the computer
is disabled, an error message may appear because the computer cannot collect
the machine status.

3. Set the quiet mode

If necessary, specify one of the following items:

Do not use quiet mode
Select this option when you wish to use the machine with volume of normal operating
noise.

Always use quiet mode
Select this option when you wish to reduce the operating noise of the machine.

Use quiet mode during specified hours

Select this option when you wish to reduce the operating noise of the machine during
a specified period of time.

Set the Start time and the End time of the quiet mode you wish to be activated. If
both are set to the same time, the quiet mode will not function.

»» Important

You can set the quiet mode from the operation panel of the machine, the printer
driver, or ScanGear (scanner driver).
No matter how you use to set the quiet mode, the mode is applied when you
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perform operations from the operation panel of the machine or printing and
scanning from the computer.

If you specify a time for Use quiet mode during specified hours, quiet mode
is not applied to operations (copy, direct print, etc.) performed directly from the
machine.

4. Apply the settings

Make sure that the machine is on and click OK.
Click OK when the confirmation message appears.

The settings are enabled hereafter.

»» Note

The effects of the quiet mode may be less depending on the print quality settings.
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Changing the Machine Operation Mode

If necessary, switch between various modes of machine operation.

The procedure for configuring Custom Settings is as follows:

— | Custom Settings

1. Open the printer driver setup window

2. Make sure that the machine is on, and then click Custom Settings on
the Maintenance tab

The Custom Settings dialog box opens.

»» Note

If the machine is off or if communication between the machine and the computer
is disabled, an error message may appear because the computer cannot collect
the machine status.

If this happens, click OK to display the most recent settings specified on your
computer.

3. If necessary, complete the following settings:

Prevent paper abrasion

The machine can increase the gap between the print head and the paper during high-
density printing to prevent paper abrasion.

Check this check box to prevent paper abrasion.

Align heads manually

Usually, the Print Head Alignment function on the Maintenance tab is set to
automatic head alignment, but you can change it to manual head alignment.

If the printing results are unsatisfactory even after you execute automatic head
alignment, execute manual head alignment.

Check this check box to perform the manual head alignment. Uncheck this check box
to perform the automatic head alignment.

Prevent paper double-feed
Select this check box only if the machine is feeding multiple sheets of plain paper at
the same time.
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»» Important

Using this function slows down the print speed.

Rotate 90 degrees left when orientation is [Landscape]

On the Page Setup tab, you can change the rotation direction of the Landscape in
the Orientation.

To rotate the print data 90 degrees to the left during printing, select this item. To
rotate the print data 90 degrees to the right during printing, clear this item.

»» Important

Do not change this setting while the print job is displayed in the print wait list.
Otherwise, characters may be omitted or the layout may become corrupt.

Detect the paper width when printing from computer

When you print from the computer, this function identifies the paper that was loaded
into this machine.

When the paper width detected by the machine differ from the width of the paper
specified in Page Size on the Page Setup tab, a message is displayed.

To use paper width detection when printing from the computer, select the check box.

»» Important

If you are using user-defined paper, use the Custom Paper Size to correctly set
the size of the paper loaded in the machine.
If an error message is displayed even though the same size that was set is
loaded, clear the check box.

Ink Drying Wait Time

You can set the length of the machine rest time until printing of the next page begins.
Moving the slider to the right increases the pause time, and moving the slider to the
left decreases the time.

If the paper gets stained because the next page is ejected before the ink on the
printed page dries, increase the ink drying wait time.

Reducing the ink drying wait time speeds up printing.

. Apply the settings
Click OK and when the confirmation message appears, click OK.

The machine operates with the modified settings hereafter.
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Changing the Machine Settings Using the Operation Panel

= About Quiet setting
= Turning on/off the Machine Automatically
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About Quiet setting

Enables this function on the machine if you want to reduce the operating noise, such as when printing at
night.

Follow the procedure below to perform setting.

1. Make sure that the machine is turned on.

2. Press and hold the Stop button until the Alarm lamp flashes 9 times.
3. Release the Stop button.

4. Press the Color button.

To disable the function, press the Black button in step 4.

2% Important

» Operating speed may be reduced compared to when the quiet mode is not selected.

¥ Note

* You can set the quiet mode from the operation panel of the machine, the printer driver, or
ScanGear (scanner driver). No matter how you use to set the quiet mode, the mode is applied
when you perform operations from the operation panel of the machine or printing and scanning
from the computer.
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Turning on/off the Machine Automatically

You can enable the machine to turn on/off automatically considering the environment

= Turning on the Machine Automatically

= Turning off the Machine Automatically

Turning on the Machine Automatically

You can enable the machine to turn on automatically when a scanning command from a computer or
printing data is sent to the machine.

1. Make sure that the machine is turned on.

2. Press and hold the Stop button until the Alarm lamp flashes 14 times.
3. Release the Stop button.

4. Press the Color button.

To disable the function, press the Black button in step 4.

»» Note

* You can select whether you turn the machine on automatically from the operation panel of the
machine, the printer driver, or ScanGear (scanner driver). No matter how you use to set the quiet
mode, the mode is applied when a scanning command from a computer or printing data is sent
to the machine.

Turning off the Machine Automatically

You can enable the machine to turn off automatically when no operation is made or no printing data is
sent to the machine for a specified period of time.

1. Make sure that the machine is turned on.

2. Press and hold the Stop button until the Alarm lamp flashes 13 times.
3. Release the Stop button.

4. Press the Color button.

To disable the function, press the Black button in step 4.

2 Note

* You can select whether you turn off the machine automatically from the operation panel of the
machine, the printer driver, or ScanGear (scanner driver). From the printer driver or ScanGear
(scanner driver), you can specify the time before turning off the machine.
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Information about Network Connection

= Useful Information about Network Connection
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Useful Information about Network Connection

= |nitial Values Set at Factory (Network)

= Connecting the Machine to the Computer Using a USB Cable

= \When Detecting the Printers Have the Same Name during Setup

= Connecting to Other Computer with LAN/Changing the Connection Method from USB to LAN
= Printing Out Network Setting Information
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Initial Values Set at Factory (Network)

Item Initial Values
Enable/disable Wireless LAN Enable
SSID BJNPSETUP
Communication mode Infrastructure
Wireless LAN security Disable
IPv4 IP address Auto setup
IPv6 IP address Auto setup
Set printer name XXXXXX000000
Enable/disable IPv6 Enable
Enable/disable WSD (WSD settings) Enable
Timeout setting (WSD settings) 1 minute
Enable/disable Bonjour (Bonjour settings) | Enable
Service name (Bonjour settings) Canon MG3500 series
LPR protocol setting Enable
Wireless LAN DRX Enable

("X" is the last six digits of MAC address.)
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Connecting the Machine to the Computer Using a USB Cable

Connect the machine and the computer using a USB cable as the illustration below. The USB port is located
on the rear of the machine.
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When Detecting the Printers Have the Same Name during Setup

When the printer is detected during setup, you may see multiple printers of the same name on the detection
result screen.

Select a printer with checking the MAC address set to the printer against the MAC address on detection
result screen.

To check the MAC address of the printer, print out the network setting information using the operation panel
of the printer.

= Printing Out Network Setting Information
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Connecting to Other Computer with LAN/Changing the Connection
Method from USB to LAN

To add the computer connecting the printer with LAN or to change the connection method between the
printer and the computer from USB to LAN, perform setup with the Setup CD-ROM or perform it according
to the instructions on our website.

Connecting to Other Computer with LAN

To add the computer connecting the printer with LAN, perform setup with the Setup CD-ROM or perform it
according to the instructions on our website.

Changing the Connection Method from USB to LAN

To change the connection method between the printer and the computer from USB to LAN, perform setup
with the Setup CD-ROM or perform it according to the instructions on our website.

To change the connection method to LAN while you are using the printer with USB connection, perform
setup again with the Setup CD-ROM or perform it again according to the instructions on our website and
select Change Connection Method.
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Printing Out Network Setting Information

You can print out the network settings of the machine such as its IP address and SSID.

3» Important

 This print out contains valuable information about your computer. Handle it with care.

1. Make sure that the machine is turned on.

2. Load a sheet of A4 or Letter-sized plain paper.

3. Press and hold the Stop button until the Alarm lamp flashes 15 times.

4. Release the Stop button.

The machine starts printing the network setting information.

The following information on the machine's network setting is printed out.

Item Explanations of the item Setting

Wireless LAN Wireless LAN Enable/Disable

Connection Status of the Wireless LAN Active/lnactive

MAC Address MAC Address XXXXXX XX XX XX

SSID SSID SSID of the wireless LAN

Communication Mode [ Communication Mode Infrastructure

Channel Channel XX (110 13)

Encryption Method of the Encryption none/WEP/TKIP/AES

WEP Key Length WEP Key Length Inactive/128/64

Authentication Method of the Authentication none/auto/open/shared/WPA-PSK/WPA2-PSK

Signal Strength Signal Strength 0 to 100 [%]

TCP/IP Version TCP/IP Version IPv4 & IPv6/IPv4

IPv4 IP Address Selected IP Address (IPv4) XXX XXX XXX XXX

IPv4 Default Gateway Default Gateway (IPv4) XXX XXX XXX XXX

Subnet Mask Subnet Mask XXX XXX XXX XXX

IPv6 IP Address *1 Selected IP Address (IPv6) XXXXXXXX X XXX XXXX
XXXX XXX XXXXKXXXX

IPv6 Default Gateway *1 | Default Gateway (IPv6) XXXX XXX XX XX XXXX
XXXX XXX XXXXKXXXX
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LAN)

Subnet Prefix Length*1 | Subnet Prefix Length XXX

IPsec*2 IPsec setting Active

Security Protocol*2 Method of the Security Protocol ESP/ESP & AH/AH
WPS PIN CODE WPS PIN code XXXXXXXX
Wireless LAN DRX Discontinuous reception (wireless Enable/Disable

Other Settings

Other settings

Printer Name

Printer name

Printer name (Up to 15 characters)

WSD WSD setting Enable/Disable
WSD Timeout Timeout 1/5/10/15/20 [min]
LPR Protocol LPR protocol setting Enable/Disable
Bonjour Bonjour setting Enable/Disable

Bonjour Service Name

Bonjour service name

Bonjour service name (Up to 52 characters)

DNS Server Getting DNS Server automatically Auto/Manual

Primary Server Primary server address XXXXXX XXX XXX
Secondary Server Secondary server address XXX XXX XXX XXX

Proxy Server Proxy Server setting Enable/Disable

Proxy Port Specifying Proxy Port 1 to 65535

Proxy Address Proxy Address XXXXXXXXXXXXXXXXXXXX
IP Address Filtering IP Address Filtering Enable/Disable

("XX" represents alphanumeric characters.)

*1 Only when IPv6 is activated, the status of the network is printed.

*2 Only IPv6 and the IPsec setting are activated, the status of the network is printed.
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About Network Communication

= Changing and Confirming Network Settings

= Screens for Network Connection of IJ Network Tool
= Other Screens of |J Network Tool

= Appendix for Network Communication
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Changing and Confirming Network Settings

LR 2R 20 2R 2R BE B 2R

IJ Network Tool

Changing the Settings in the Wireless LAN Sheet
Changing the WEP Detailed Settings

Changing the WPA or WPA2 Detailed Settings
Changing the Settings in the Wired LAN Sheet
Changing the Settings in the Admin Password Sheet
Monitoring Wireless Network Status

Initializing the Network Settings of the Machine
Viewing the Modified Settings
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IJ Network Tool

IJ Network Tool is a utility that enables you to display and modify the machine network settings. It is installed
when the machine is set up.

2% Important

» To use the machine over LAN, make sure you have the equipment necessary for the connection type,
such as an access point or a LAN cable.

* Do not start up IJ Network Tool while printing.
» Do not print when IJ Network Tool is running.

« If the firewall function of your security software is turned on, a message may appear warning that
Canon software is attempting to access the network. If the warning message appears, set the security
software to always allow access.

* |1J Network Tool has been verified to work on Windows XP, however, it does not support Fast User
Switching. It is recommended to exit IJ Network Tool when switching users.

Starting up IJ Network Tool

1. Start up IJ Network Tool as shown below.

* In Windows 8, select IJ Network Tool on the Start screen to start IJ Network Tool. If IJ Network
Tool is not displayed on the Start screen, select the Search charm, then search for "IJ Network
Tool".

* In Windows 7, Windows Vista, or Windows XP, click Start and select All programs, Canon
Utilities, IJ Network Tool, and then IJ Network Tool.

»» Note

* You can also start up IJ Network Tool by clicking m Network Settings from Device Settings
& Maintenance on Quick Menu.
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Changing the Settings in the Wireless LAN Sheet

To change the wireless network settings of the printer, connect the printer and the computer with a USB
cable temporarily. If you modify the wireless network settings of the computer over wireless connection
without USB connection, your computer may not be able to communicate with the machine after modifying
the settings.

»» Note

* This screen is not available depending on the printer you are using.

+ Activate the wireless LAN setting of the printer to change the settings in the Wireless LAN sheet.

1. Start up IJ Network Tool.

2. Select the printer in Printers:.

When the printer is connected to the computer with a USB cable temporarily, select the printer with
"USBnnn" (where "n" is a number) appearing in the Port Name column.

3. Select Configuration... from the Settings menu.

4. Click the Wireless LAN tab.

The Wireless LAN sheet is displayed.

Wirnleas LAN | Adein Password
o
Matwork Types
8| Infrastructure
S5IC g Search
Encryption Method: | Use WEP ¥ | Configurtion
TCP/AF Setup WGl |P acireas mol omadicaly

Ulse: need 1P axcidress

rsjruciors 0% Cancsl

For details on the Wireless LAN sheet, see Wireless LAN Sheet.

5. Change the settings or confirm.

SSID:
Enter the same value that was set for the target access point.

When the printer is connected with USB, the Search screen appears by clicking Search.... Set the
SSID of the access point by selecting the one of the detected access points.

= Search Screen
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»» Note

» Enter the same SSID that the access point is configured to use. The SSID is case-sensitive.

Encryption Method:
Select the encryption method used over the wireless LAN.

You can change WEP settings with selecting Use WEP and clicking Configuration....

= Changing the WEP Detailed Settings

You can change WPA or WPAZ2 settings with selecting Use WPA or Use WPA2 and clicking
Configuration....

= Changing the WPA or WPA2 Detailed Settings

3» Important

« If all encryption types of the access point, printer, or computer do not match, the printer cannot
communicate with the computer. If the printer cannot communicate with the computer after the
encryption type of the printer was switched, make sure that encryption types for the computer and the
access point matches that set to the printer.

« If you connect to a network that is not protected with security measures, there is a risk of disclosing
data such as your personal information to a third party.

TCPI/IP Setup:
Sets the IP address of the printer to be used over the LAN. Set a value appropriate for your network

environment.

. Click OK.

After changing configuration, a screen is displayed asking you for confirmation before the settings are
sent to the printer. If you click Yes, the settings are sent to the printer and the Transmitted Settings
screen is displayed.

»» Note

» Changing the network settings with the USB cable temporarily may switch the default printer. In this
case, reset Set as Default Printer.
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Changing the WEP Detailed Settings

»» Note

» This screen is not available depending on the printer you are using.

To change the wireless network settings of the printer, connect the printer and the computer with a USB
cable temporarily. If you modify the wireless network settings of the computer over wireless connection
without USB connection, your computer may not be able to communicate with the machine after modifying
the settings.

1. Start up IJ Network Tool.

2. Select the printer in Printers:.

When the printer is connected to the computer with a USB cable temporarily, select the printer with

"USBnnn" (where "n" is a number) appearing in the Port Name column.

3. Select Configuration... from the Settings menu.

4. Click the Wireless LAN tab.

5. Select Use WEP in Encryption Method: and click Configuration....

The WEP Details screen is displayed.

6. Change the settings or confirm.

When changing the password (WEP key), the same change must be made to the password (WEP key) of
the access point.

WEP Details E
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1. WEP Key:
Enter the same key as the one set to the access point.

The number of characters and character type that can be entered differ depending on the key
length and key format.

Key Length

64bit 128bit

Key Format | ASCII 5 characters | 13 characters
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Hexadecimal (Hex)

10 digits

26 digits

2. Key Length:

Select either 64bit or 128bit.
3. Key Format:

Select either ASCII or Hex.
4. Key ID:

Select the Key ID (index) set to the access point.

5. Authentication:

Select the authentication method to authenticate the printer's access to the access point.

Normally, select Auto. If you want to specify the method manually, select Open System or Shared

Key according to the setting of the access point.

7. Click OK.

2% Important

« If the printer cannot communicate with the computer after the encryption type of the printer was
switched, make sure that encryption types for the computer and the access point matches that set

to the printer.

»» Note

» Changing the network settings with the USB cable temporarily may switch the default printer. In this

case, reset Set as Default Printer.
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Changing the WPA or WPA2 Detailed Settings

»» Note

» This screen is not available depending on the printer you are using.

To change the wireless network settings of the printer, connect the printer and the computer with a USB
cable temporarily. If you modify the wireless network settings of the computer over wireless connection
without USB connection, your computer may not be able to communicate with the machine after modifying
the settings.

The example screenshots in this section refer to the WPA detailed settings.

1. Start up |J Network Tool.

2. Select the printer in Printers:.

When the printer is connected to the computer with a USB cable temporarily, select the printer with

"USBnnn" (where "n" is a number) appearing in the Port Name column.

3. Select Configuration... from the Settings menu.

4. Click the Wireless LAN tab.

5. Select Use WPA or Use WPA2 in Encryption Method: and click Configuration...

The WPA Details screen is displayed (For WPA2, the WPA2 Details screen is displayed).

If encryption is not set to the printer, the Authentication Type Confirmation screen is displayed. Go to
step 7.

6. Click Change Settings....

WPA Details H
The cument seftings for clent authentication ane as follows. To change

the seftings. dick [Change Setftings)]

FAuthenbcation Type P5K

Dynamic Encryption Type TKIP {Bssic Encryplion}

Insiruciions 0K

7. Check the client authentication type and click Next>.
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8. Enter the passphrase, confirm the type of dynamic encryption and click Next>.

Enter the passphrase set to the access point. The passphrase should be a string of 8 to 63 alphanumeric
characters or a 64-digit hexadecimal value.

If you do not know the access point passphrase, refer to the instruction manual provided with the access
point or contact its manufacturer.

Enter the passphrase, select the dynamic encrypbion type, and
then click [Med].
[ynamic Encryption Typa
() THJP (Biase: Encrypion)
[ AES{Secure Encryption)
=

9. Click Finish.

l;h-d:;h seitings for chent authentication. and then cick

Mu'ﬂuih'lﬁpﬂ-’. PSK

Dynamc Encryption Type: THIP (Basic Encryption)
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2% Important

« If the printer cannot communicate with the computer after the encryption type of the printer was
switched, make sure that encryption types for the computer and the access point matches that set
to the printer.

P Note

» Changing the network settings with the USB cable temporarily may switch the default printer. In this
case, reset Set as Default Printer.

165



Changing the Settings in the Wired LAN Sheet

»» Note

» This screen is not available depending on the printer you are using.

+ Activate the wired LAN setting of the printer to change the settings in the Wired LAN sheet.

1. Start up IJ Network Tool.

2. Select the printer in Printers:.
3. Select Configuration... from the Settings menu.

4. Click the Wired LAN tab.
The Wired LAN sheet is displayed.

Wirpd LAN  Adminy Password

o
TCPAP Satup ® Gt |P address guiomaticaly
Lise re 1P axcienes

res{nuctions 0% Cancal

For details on the Wired LAN sheet, see Wired LAN Sheet.

5. Change the settings or confirm.

Sets the IP address of the printer to be used over the LAN. Set a value appropriate for your network
environment.

6. Click OK.

After changing configuration, a screen is displayed asking you for confirmation before the settings are
sent to the printer. If you click Yes, the settings are sent to the printer and the Transmitted Settings

screen is displayed.
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Changing the Settings in the Admin Password Sheet

1. Start up IJ Network Tool.

2. Select the printer in Printers:.

3. Select Configuration... from the Settings menu.

4. Click the Admin Password tab.

The Admin Password sheet is displayed.

Wirsleas LAN | Admin Password
o | Use gdmin password

Password

Prssward Confimatan

sjructons 0K Cancel

For details on the Admin Password sheet, see Admin Password Sheet.

5. Change the settings or confirm.
To use admin password, select the Use admin password check box and enter a password.

2% Important

» The password should consist of alphanumeric characters and be no longer than 32 characters. The
password is case-sensitive. Do not forget the password you set.

6. Click OK.

A screen is displayed asking you for confirmation before the settings are sent to the printer. If you click
Yes, the settings are sent to the printer and the Transmitted Settings screen is displayed.
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Monitoring Wireless Network Status

22> Note

» This screen is not available depending on the printer you are using.

* When using the machine over the wired LAN, you cannot monitor network status.

1. Start up IJ Network Tool.

2. Select the printer in Printers:.

3. Select Status from the View menu.

The Status screen is displayed and you can check the printer status and connection performance.

%% Important

« If the indicated value is low, move your printer closer to the wireless network device.

4. If you measure the connection performance in detail, click Advanced Measurement...

The Connection Performance Measurement screen is displayed.

5. Click Next>.

The measurement starts and the status displays. Measurement takes a few minutes.

This vezard vell maasure the cornection perfaemance betwesn the panber and
e access point. and deplay wihether | it sultable for printing.
Chonch that the prinker is bumed on_ and click [Nest]

'When the: connection pesformance is poor, mmmw&um

- B owill 1ake & coupls of minules 1o measune the cornection
Hmmmﬂmwﬂhm:nw:

neuctions e T
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6. Check the status.

When the measurement is complete, the status is displayed.

Thee realta ane 20 folows

o
i {[‘T"r
b =

Cornaction Perfomance betessn the Printer and the Access Pont
—— T EEmm s L1

[

Chicke [Remaasuremant| o maasues the pafomancs again

Instructions Back Enish

When 0 is displayed in Connection Performance between the Printer and the Access Point:, the
printer can communicate with the access point. Otherwise, refer to displayed comments and the following
to improve the status of communication link, and click Remeasurement.

Check that the printer and the access point are located within the wireless connectivity range with
no obstacles between them.

Check if the distance between the printer and the access point is not too far.
If they are too far, move them closer together (within 164 ft./50 m).
Check that there is no barrier or obstacle between the printer and the access point.

In general, connection performance decreases for communications through walls or between
different floors. Adjust the locations to avoid such situations.

Check that there are no sources of radio interference near the printer and the access point.

The wireless connection may use the same frequency band as microwave ovens and other sources
of radio interference. Try to keep the printer and the access point away from such sources.

Check if the radio channel of the access point is close to that of other access points nearby.

If the radio channel of the access point is close to that of other access points nearby, the connection
performance may become unstable. Be sure to use a radio channel that does not interfere with
other access points.

Check that the printer and the access point face each other.

Connection performance may depend on the orientations of the wireless devices. Replace the
access point and the printer in another direction to achieve the best performance.

Check whether other computers are not accessing the printer.

If @ appears in the result of the measurement, check whether other computers are not accessing
the printer.
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If@ still appears even if you have tried the above, finish the measurement, then restart the IJ Network
Tool to start over the measurement.

7. Click Finish.
»» Note

+ If any messages appear on Overall Network Performance:, move the machine and access point
as instructed to improve the performance.
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Initializing the Network Settings of the Machine

2» Important

* Note that initialization erases all network settings on the machine, printing or scanning operation from a
computer over network may become impossible. To use the machine over network, perform setup with
the Setup CD-ROM or perform setup according to the instructions on our website.

1. Start up IJ Network Tool.

2. Select the printer in Printers:.

3. Select Maintenance... from the Settings menu.

The Maintenance screen is displayed.

4. Click Initialize.

Setfireg Intial rabon
T petuam the prinder setiings to the faciony defaulls, chck [initisize]

Metwod: Sebup of the Card Slot

¥ youl plan to use the cand sol via the nebwor, cick [Sebup)
Stabus: Mot set

Instraciicons O Cancsl

5. When the confirmation screen is displayed, click Yes.

initialize Settings x|

Retumns the printer settings to the factory defaults

Initialize settings?
. HD

The network settings of the printer is initialized.

Do not turn off the printer during initialization.
Click OK when initialization is complete.

Performing initialization when connected over wireless LAN will break the connection, so perform setup
with the Setup CD-ROM or perform setup according to the instructions on our website.

»» Note

* You can change the network settings of the printer using IJ Network Tool with USB connection after
initializing the LAN settings. To change the network settings using Canon IJ Network Tool, activate
wireless LAN in advance.
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Viewing the Modified Settings

The Confirmation screen is displayed when you modified the printer settings on the Configuration screen.
When you click Yes on the Confirmation screen, the following screen is displayed for confirming the
modified settings.

The followang settings were seni o the: printer,

Gettngs

ltem Setting Value
Adimin Passwond Lise
Adimiry Password Sl up

—
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Screens for Network Connection of |J Network Tool

L3R 2R 2R 2E 2R B0 B AR 2R R 2R 2E 2 2R BN

Canon |J Network Tool Screen

Configuration Screen

Wireless LAN Sheet

Search Screen

WEP Details Screen

WPA Details Screen

WPAZ2 Details Screen

Authentication Type Confirmation Screen

PSK: Passphrase and Dynamic Encryption Setup Screen

Setup Information Confirmation Screen

Wired LAN Sheet

Admin Password Sheet

Network Information Screen

Access Control Sheet

Edit Accessible MAC Address Screen/Add Accessible MAC Address Screen
Edit Accessible IP Address Screen/Add Accessible IP Address Screen
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Canon IJ Network Tool Screen

This section describes the items and menus displayed on the Canon IJ Network Tool screen.

= [tems on the Canon |J Network Tool Screen

= Canon |J Network Tool Menus

Items on the Canon IJ Network Tool Screen

The following item is displayed on the Canon IJ Network Tool screen.

wd Canon Ll Netwerk Tool ﬂ
Eide View Settings Help
Frnlen
Harme St Moaded Post Name
- Canon Sy e . Avaiable  Canon SIS 75850y 1

Tl

F the prnber you nbend 10 uss is Aot debacied, refer 1o the |Instnucions], and check the
settings. Check the status of the printer 1o configune the seSings

I vy tabos & ferw mirwtes for @ prinder to be visible on the network after £ i tumed on
Plaase wal & whils and then click [Update)

1. Printers:

The printer name, status, printer model name, and port name are displayed.

A check mark next to the printer in the Name list indicates it is set as the default printer.

Configuration changes are applied to the selected printer.

2. Update

Performs printer detection again. Click this button if the target printer is not displayed.

3% Important

To change the printer's network settings using IJ Network Tool, it must be connected via a LAN.
If No Driver is displayed for the name, associate the port with the printer.

= \When the Printer Driver Is Not Associated with a Port

If Not Found is displayed for the status, check the followings:
» The access point is turned on.
* When using wired LAN, the LAN cable is connected properly.

If the printer on a network is not detected, make sure that the printer is turned on, then click
Update. It may take several minutes to detect printers. If the printer is not yet detected, connect
the machine and the computer with a USB cable, then click Update.

If the printer is being used from another computer, a screen is displayed informing you of this
condition.

174



»» Note

« This item has the same function as Refresh in the View menu.

3. Configuration...

Click to configure settings of the selected printer.

= Configuration Screen
»» Note

* You cannot configure a printer that has the status Not Found.

» This item has the same function as Configuration... in the Settings menu.

Canon IJ Network Tool Menus

The following menu is displayed from the Canon IJ Network Tool screen.

1 2 3 4

‘Wu Network Tool Ex
[ Hetp]

bor] [ g

' Fils Iy_-eu- Hﬁettmgsl 1
Frnlen

Harme St Moaded Post Name

Updiate Corfiguraten

F the prnber you nbend 10 uss is Aot debacied, refer 1o the |Instnucions], and chsck the
settings. Check the status of the printer 1o configune the seSings

I vy tabos & ferw mirwtes for @ prinder to be visible on the network after £ i tumed on
Plaase wal & whils and then click [Update)

1. File menu

Exit
Exits IJ Network Tool.

2. View menu

Status
Displays the Status screen to confirm the printer connection status and wireless communication

status.
= Status Screen

Refresh
Updates and displays the contents of Printers: on the Canon IJ Network Tool screen to the latest

information.

2» Important

» To change the printer's network settings using IJ Network Tool, it must be connected via a LAN.

+ If No Driver is displayed for the name, associate the port with the printer.

= \When the Printer Driver Is Not Associated with a Port

175



+ If Not Found is displayed for the status, check the followings:
* The access point is turned on.
* When using wired LAN, the LAN cable is connected properly.

« If the printer on a network is not detected, make sure that the printer is turned on, then select
Refresh. It may take several minutes to detect printers. If the printer is not yet detected, connect
the machine and the computer with a USB cable, then select Refresh.

« If the printer is being used from another computer, a screen is displayed informing you of this
condition.

> Note

» This item has the same function as Update in the Canon IJ Network Tool screen.

Network Information
Displays the Network Information screen to confirm the network settings of the printer and the
computer.

= Network Information Screen

Display Warning Automatically
Enables or disables automatic display of the instruction screen.

When this menu is selected, the instruction screen is displayed if one or more ports are unavailable
for printing.

. Settings menu

Configuration...
Displays the Configuration screen to configure settings of the selected printer.

= Configuration Screen

»» Note

+ This item has the same function as Configuration... in the Canon IJ Network Tool screen.

Associate Port...
Displays the Associate Port screen and you can associate a port with the printer.

= Associate Port Screen

This menu is available when No Driver is displayed for the selected printer. Associating a port with
the printer enables you to use it.

Maintenance...
Displays the Maintenance screen to revert the network settings of the printer to factory default and
to mount the card slot as the network drive.

= Maintenance Screen

. Help menu

Instructions
Displays this guide.

About
Displays the version of IJ Network Tool.
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Configuration Screen

You can change the configuration of the printer selected on the Canon IJ Network Tool screen.
Click the tab to select the sheet to change the settings.

The following screen is the example to change the setting on the Wireless LAN sheet.

22> Note

» This screen is not available depending on the printer you are using.

Virnieas LAN | Admin Password

o Lse the panber with wrsless LAN connection
Matwioek Topsa:
) Ifrastructne
55D Lea o o Search
Encrvption Mathod: | Lse WEP v | | Configurstion

TCPAP Sehup: (@) Get |P address guicmatically
) se neod IF address

For details on each sheet, see the following.
= Wireless LAN Sheet
= \Wired LAN Sheet

= Admin Password Sheet
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Wireless LAN Sheet

»» Note

» This screen is not available depending on the printer you are using.

Allows you to set the printer with wireless LAN connection.

To display the Wireless LAN sheet, click the Wireless LAN tab on the Configuration screen.

Wirsless LAN | Adkmin Password

W

Matwork Typs

® infrastructunes

2
551D (r—wras ) seaeh. }—3

Encryotsn Mathod: | Use WEP [ corbigrntion }—— B
: 4

TCPAP Sehup & et |P address mdomaticaly
Use necd IF address

Insjructorns oK Cancel

1. Network Type:

Infrastructure
Connects the printer to the wireless LAN with an access point.

2. SSID:

The SSID of the wireless LAN is displayed.

As the initial settings, the unique value is displayed.

»» Note

» Enter the same SSID that the access point is configured to use. The SSID is case-sensitive.

3. Search...

The Search screen is displayed to select an access point to connect to.

= Search Screen

»» Note

» When IJ Network Tool runs over a LAN, the button is grayed out and cannot be selected. Connect
the printer and the computer with a USB cable temporarily to change the settings.

4. Encryption Method:

Select the encryption method used over the wireless LAN.
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Do not use
Select to disable encryption.

Use WEP
Transmission is encrypted using a WEP key you specified.

If a WEP key has not been set, the WEP Details screen is displayed automatically. To change WEP
settings set before, click Configuration... to display the screen.

= Changing the WEP Detailed Settings

Use WPA/Use WPA2
Transmission is encrypted using a WPA or WPA2 key you specified.

The security has been strengthened more than WEP.

If a WPA or WPA2 key has not been set, the Authentication Type Confirmation screen is displayed
automatically. To change WPA or WPA2 settings set before, click Configuration... to display the
WPA Details screen or WPA2 Details screen.

= Changing the WPA or WPA2 Detailed Settings

5. Configuration...

The detailed settings screen is displayed. The WEP, the WPA, or the WPAZ2 key selected in Encryption
Method: can be confirmed and changed.

For details on WEP setting:
= Changing the WEP Detailed Settings

For details on WPA or WPA2 setting:
= Changing the WPA or WPA2 Detailed Settings

6. TCP/IP Setup:

Sets the IP address of the printer to be used over the LAN. Set a value appropriate for your network
environment.

Get IP address automatically
Select this option to use an IP address automatically assigned by a DHCP server. DHCP server
functionality must be enabled on your wireless LAN router or access point.

Use next IP address
If no DHCP server functionality is available in your setup where you use the printer or you want to
use a particular IP address, select this option to use a fixed IP address.
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Search Screen

»» Note

» This screen is not available depending on the printer you are using.

The access points detected are listed.
Search [ x |

The followang access ponts wene delected
Select the sconss point to conmect 1o, and clck [Sat]

Detected Access Poirts
Strergth Encryption Aceass Point Charred

il (wep 1
T WRA YN o C
Ti WPAZ i wam i

et Cacel

1. Detected Access Points:

The signal strength from the access point, encryption type, name of access point, and the radio channel
can be confirmed.
2% Important

« If you connect to a network that is not protected with security measures, there is a risk of disclosing
data such as your personal information to a third party.

P Note

+ Signal strength is displayed as follows.

Til: Good
T - Fair
T : Poor
» Type of encryption is displayed as follows.
Blank: No encryption
WEP: WEP is set
WPA: WPA is set
WPA2: WPA2 is set

2. Update
Click to update the list of access points when your target access point is not detected.

If the target access point is set to the stealth mode, click Cancel to return to the previous screen and
enter the access point's SSID in SSID: on the Wireless LAN sheet.

= \\Vireless LAN Sheet
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¥ Note

* When detecting your target access point, make sure that the access point is turned on.

3. Set

Click to set the access point's SSID in SSID: on the Wireless LAN sheet.
»» Note

» The WEP Details screen, the WPA Details screen, or the WPA2 Details screen appears if the
selected access point is encrypted. In this case, configure the details to use the same encryption
settings set to the access point.

» Access points that cannot be used by this machine (including those configured to use different
encryption methods) are displayed grayed out and cannot be configured.
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WEP Details Screen

»» Note

» This screen is not available depending on the printer you are using.

Specify the printer WEP settings.

WEP Details u
[wep key =1
{ Ky Longin 12808 2
[Kz:.- Fomat ASCH «-]— 3
(e 0 i 4
[i\lhrrl:r_.u:,m LT H]— 5
Indlf icliong 0K Cancsl

»» Note

» When changing the password (WEP key) of the printer, the same change must be made to the
password (WEP key) of the access point.

1. WEP Key:

Enter the same key as the one set to the access point.

The number of characters and character type that can be entered differ depending on the key length and

key format.
Key Length
64bit 128bit
Key Format | ASCII 5 characters | 13 characters
Hexadecimal (Hex) [ 10 digits 26 digits

2. Key Length:

Select either 64bit or 128bit.

3. Key Format:

Select either ASCII or Hex.

4. Key ID:

Select the Key ID (index) set to the access point.

5. Authentication:

Select the authentication method to authenticate the printer's access to the access point.

Select Auto or Open System or Shared Key.
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WPA Details Screen

22> Note

» This screen is not available depending on the printer you are using.

Specify the printer WPA settings.

The value displayed on the screen differs depending on the present settings.

The cumeni sefings for cient authentication ane as folows. To changs
the sefiings. ciick [Change Settings]
[Authentication Type =3, 1
| vmame Encryption Time THIP {Basic Encryptieri } 2
-3
Instructins 0K

1. Authentication Type:

Displays the type of authentication used for client authentication. This machine supports the PSK
authentication method.

2. Dynamic Encryption Type:

Displays the dynamic encryption method.

3. Change Settings...

Displays the Authentication Type Confirmation screen.

= Authentication Type Confirmation Screen

183



WPAZ2 Details Screen

22> Note

» This screen is not available depending on the printer you are using.

Specify the printer WPA2 settings.

The value displayed on the screen differs depending on the present settings.

The cumeni sefings for cient authentication ane as folows. To changs

the seftings. ciick [Change Settings]

[Athentication Type Psk } 1

[Bmamic: Encrypion Type: THIF {Basic Encrypion) 2
3

1. Authentication Type:

Displays the type of authentication used for client authentication. This machine supports the PSK
authentication method.

2. Dynamic Encryption Type:

Displays the dynamic encryption method.

3. Change Settings...

Displays the Authentication Type Confirmation screen.

= Authentication Type Confirmation Screen
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Authentication Type Confirmation Screen

22> Note

» This screen is not available depending on the printer you are using.

Type of authentication used for client authentication is displayed.

Check the authentication type. and chok [hed]
Autheniscabion Type
oBSK T’
Instructions Bock [ Mew» | [ Cancel

1. Authentication Type

Type of authentication used for client authentication is displayed.

PSK
This machine supports the PSK authentication method.

This authentication type PSK uses a passphrase.
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PSK: Passphrase and Dynamic Encryption Setup Screen

22> Note

» This screen is not available depending on the printer you are using.

Enter the passphrase and select the dynamic encryption method.

Erter the passphrase., select the dynamic encrypbon type, and
then click; [Mexd]
[Em ]'-1
Dynamsc Encryption Type
(%) TEIF(Basc Encryption) L
() AES{Secure Encryption)
Instructions chack | [edt> Cancel

1. Passphrase:

Enter the passphrase set to the access point. The passphrase should be a string of 8 to 63 alphanumeric
characters or a 64-digit hexadecimal value.

If you do not know the access point passphrase, refer to the instruction manual provided with the access
point or contact its manufacturer.

2. Dynamic Encryption Type

Select the dynamic encryption method from either TKIP (Basic Encryption), or AES (Secure
Encryption) according to the setting of the access point.
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Setup Information Confirmation Screen

19> Note

» This screen is not available depending on the printer you are using.

Displays the settings used for client authentication.

Confirm the settings and click Finish.

ﬂud:}ﬂ'u seifings for chent authentication. and then dick

FAuthertication Type: PSK

Dynamc Encryption Type: THIF (Basic Encryption)
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Wired LAN Sheet

»» Note

» This screen is not available depending on the printer you are using.

Allows you to set the printer with wired LAN connection.

To display the Wired LAN sheet, click the Wired LAN tab on the Configuration screen.

Configuration “

Weed LAN  Admin Password

TEPAP Sehup ® (et IF adoress puiomaticaly
Liss resd IF addenss

Insjructorns oK Cancel

1. TCPI/IP Setup:

Sets the IP address of the printer to be used over the LAN. Set a value appropriate for your network
environment.

Get IP address automatically

Select this option to use an IP address automatically assigned by a DHCP server. DHCP server
functionality must be enabled on your router.

Use next IP address
If no DHCP server functionality is available in your setup where you use the printer or you want to
use a particular IP address, select this option to use a fixed IP address.
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Admin Password Sheet

Set a password for the printer to allow specific people to perform setup and configurations operation.

To display the Admin Password sheet, click the Admin Password tab on the Configuration screen.

1. Use admin password

Set a password for the administrator with privileges to set up and change detailed options. To use this
feature, select this check box and enter a password.

2. Password:

Enter the password to set.

3. Password Confirmation:

Enter the password again for confirmation.
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Network Information Screen

Display the network information that is set for the printers and the computers.

To display the Network Information screen, select Network Information from the View menu.

&
Network Inforsation
Gereral Info.
L A A SN ER | i i
Wl;d!] ................. -l—l-l': —_—
OPFIMEEE . o o v 0o voaowonow o0 o 3 e R e P
MIEINP Port Name. . . . . . . . @ 60k Sl e .
DSNScarmer . . . v v v von e e R ey ey —
L T . R R | o g
(M0IRNP Port Mormitor Version . . . . . . 1 LA
spplication Info.
< *
Insipuctions [i 0K ][_cm.ﬂﬁﬂm]
_
1 2
1. OK

Returns to the Canon IJ Network Tool screen.

2. Copy All Information

All network information displayed is copy to the clipboard.
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Access Control Sheet

22> Note

» This screen is not available depending on the printer you are using.

You can register the MAC addresses or the IP addresses of computers or network devices to allow access.

To display the Access Control sheet, click the Access Control tab on the Configuration screen.

Wreless LAM | Wead LAN  Access Dontrol | Admin Passwond
[E‘rnur Access Control Type: MAL Adedr 58 W ]- =1
[ Ensble printer socess con trolldAD sddre 55)
MAL Address Commant
Edl At (£
Instructions : (=13 ] Cancel

1. Printer Access Control Type:

Select the type of access control with which to limit access of computers or network devices to the printer
over a network.

The setting items may differ depending on the choice of access control methods.

= \When Selecting MAC address

= \Vhen Selecting IP address

When Selecting MAC address

The accessible computers or network devices are specified by their MAC addresses. Computers or
network devices whose MAC addresses appear on the list are allowed access.

Wraless LaM | Wread Lap Acsess Dontrol | asmin Paseeeosd

Printer Acos 55 Control Type: WAL dddruss w

[oF| Envalsbe printer aooess oontrolAL widre ss) — 1
Accesrble WAL Addrerses

MLAL Address Commant
e I n el "

Instructions | oK Clan el
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1. Enable printer access control(MAC address)

Select to enable access control to the printer by MAC address.

» Note

» The two types of access control (i.e., by MAC address and by IP address) can be enabled at the
same time.

An access control type is enabled as long as the Enable printer access control check box is
selected, regardless of the type currently displayed by selecting in Printer Access Control
Type:.

* When both access control types are enabled at the same time, a computer or a network device
whose address is registered to either list will be allowed access to the printer.

2. Accessible MAC Addresses:

Shows the registered MAC addresses and any comments.

3. Edit...

The Edit Accessible MAC Address screen is displayed to edit the settings selected in Accessible
MAC Addresses:.

= Edit Accessible MAC Address Screen/Add Accessible MAC Address Screen

4. Add...

The Add Accessible MAC Address screen is displayed to register the MAC address of a computer or
a network device from which to access the printer over the network.

2% Important

» Add the MAC address of all computers or network devices within the network from which to
access the printer. The printer cannot be accessed from a computer or a network device that is
not on the list.

5. Delete

Deletes the selected MAC address from the list.
When Selecting IP address

The accessible computers or network devices are specified by their IP addresses. Computers or network
devices whose IP addresses appear on the list are allowed access.
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Wirikiss LAM | Wrad LAM  Access Dontrol | Asmen Passmoed

Printar dcouss Control Type 1P Addrans

o | Enalila prin bar accass ooninol]F sddress) 1
Aoce gzt P Adre 5es

IF dAgdedrai5 Comimsn t

e -

Diancal

ﬂ
I

B

Instructons

1. Enable printer access control(IP address)

Select to enable access control to the printer by IP address.

»» Note

» The two types of access control (i.e., by MAC address and by IP address) can be enabled at the
same time.

An access control type is enabled as long as the Enable printer access control check box is
selected, regardless of the type currently displayed by selecting in Printer Access Control
Type:.

* When both access control types are enabled at the same time, a computer or a network device
whose address is registered to either list will be allowed access to the printer.

2. Accessible IP Addresses:

Shows the registered IP addresses and any comments.

3. Edit...

The Edit Accessible IP Address screen is displayed to edit the settings selected in Accessible IP
Addresses:.

= Edit Accessible IP Address Screen/Add Accessible IP Address Screen

4. Add...

The Add Accessible IP Address screen is displayed to register the IP address of a computer or a
network device from which to access the printer over the network.

2% Important

» Add the IP address of all computers or network devices within the network from which to access
the printer. The printer cannot be accessed from a computer or a network device that is not on
the list.

» Up to 16 IP addresses can be registered. IP addresses specified by Range Specification are
counted as one address. Use Range Specification when you intend to register 17 or more IP
addresses.
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5. Delete

Deletes the selected IP address from the list.
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Edit Accessible MAC Address Screen/Add Accessible MAC
Address Screen

»» Note

» This screen is not available depending on the printer you are using.

The example screenshots in this section refer to the Add Accessible MAC Address Screen.

[H.Al: A g = = = i 3 J_ 1
[Qoﬂm nt ]—E
Insiructions oK Cancel

1. MAC Address:

Enter the MAC address of a computer or a network device to allow access.

2. Comment:

Optionally enter any information to identify the device, such as the name of the computer.

2% Important

« Comments will be displayed only on the computer used to enter them.
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Edit Accessible IP Address Screen/Add Accessible IP Address
Screen

»» Note

» This screen is not available depending on the printer you are using.

The example screenshots in this section refer to the Add Accessible IP Address Screen.

Add Accessible IP Address E

S pacitcaion b thod Singhe Address Specilcation w 1

T ) -
[ewwn' ]—3

Instructions [=].4 Cpnc!

1. Specification Method:
Select either Single Address Specification or Range Specification to add the IP address(es).

Single Address Specification
Specify each IP address separately.

Range Specification
Specify a range of successive IP addresses.

2. IP Address:

Enter the IP address of a computer or a network device to allow access when you selected Single
Address Specification in Specification Method:.

An IP address is expressed as four values ranging from 0 to 255.

Start IP Address:

Enter the first IP address in the range of addresses of the computers or network devices to allow

access when you selected Range Specification in Specification Method:.
An IP address is expressed as four values ranging from 0 to 255.

End IP Address:

Enter the last IP address in the range of addresses of the computers or network devices to allow

access when you selected Range Specification in Specification Method:.

An IP address is expressed as four values ranging from 0 to 255.

»» Note

* The Start IP Address: must be a smaller value than the End IP Address:.

3. Comment:
Optionally enter any information to identify the device, such as the name of the computer.

2% Important

+ Comments will be displayed only on the computer used to enter them.
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Other Screens of |J Network Tool

Canon IJ Network Tool Screen
Status Screen

Connection Performance Measurement Screen
Maintenance Screen

Network Setup of the Card Slot Screen
Associate Port Screen

Network Information Screen

L R 2R 2B 2 2R B
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Canon IJ Network Tool Screen

This section describes the items and menus displayed on the Canon IJ Network Tool screen.

= [tems on the Canon |J Network Tool Screen

= Canon |J Network Tool Menus

Items on the Canon IJ Network Tool Screen

The following item is displayed on the Canon IJ Network Tool screen.

wd Canon Ll Netwerk Tool ﬂ
Eide View Settings Help
Frnlen
Harme St Moaded Post Name
- Canon Sy e . Avaiable  Canon SIS 75850y 1

Tl

F the prnber you nbend 10 uss is Aot debacied, refer 1o the |Instnucions], and check the
settings. Check the status of the printer 1o configune the seSings

I vy tabos & ferw mirwtes for @ prinder to be visible on the network after £ i tumed on
Plaase wal & whils and then click [Update)

1. Printers:

The printer name, status, printer model name, and port name are displayed.

A check mark next to the printer in the Name list indicates it is set as the default printer.

Configuration changes are applied to the selected printer.

2. Update

Performs printer detection again. Click this button if the target printer is not displayed.

3% Important

To change the printer's network settings using IJ Network Tool, it must be connected via a LAN.
If No Driver is displayed for the name, associate the port with the printer.

= \When the Printer Driver Is Not Associated with a Port

If Not Found is displayed for the status, check the followings:
» The access point is turned on.
* When using wired LAN, the LAN cable is connected properly.

If the printer on a network is not detected, make sure that the printer is turned on, then click
Update. It may take several minutes to detect printers. If the printer is not yet detected, connect
the machine and the computer with a USB cable, then click Update.

If the printer is being used from another computer, a screen is displayed informing you of this
condition.

198



»» Note

« This item has the same function as Refresh in the View menu.

3. Configuration...

Click to configure settings of the selected printer.

= Configuration Screen
»» Note

* You cannot configure a printer that has the status Not Found.

» This item has the same function as Configuration... in the Settings menu.

Canon IJ Network Tool Menus

The following menu is displayed from the Canon IJ Network Tool screen.

1 2 3 4

‘Wu Network Tool Ex
[ Hetp]

bor] [ g

' Fils Iy_-eu- Hﬁettmgsl 1
Frnlen

Harme St Moaded Post Name

Updiate Corfiguraten

F the prnber you nbend 10 uss is Aot debacied, refer 1o the |Instnucions], and chsck the
settings. Check the status of the printer 1o configune the seSings

I vy tabos & ferw mirwtes for @ prinder to be visible on the network after £ i tumed on
Plaase wal & whils and then click [Update)

1. File menu

Exit
Exits IJ Network Tool.

2. View menu

Status
Displays the Status screen to confirm the printer connection status and wireless communication

status.
= Status Screen

Refresh
Updates and displays the contents of Printers: on the Canon IJ Network Tool screen to the latest

information.

2» Important

» To change the printer's network settings using IJ Network Tool, it must be connected via a LAN.

+ If No Driver is displayed for the name, associate the port with the printer.

= \When the Printer Driver Is Not Associated with a Port

199



+ If Not Found is displayed for the status, check the followings:
* The access point is turned on.
* When using wired LAN, the LAN cable is connected properly.

« If the printer on a network is not detected, make sure that the printer is turned on, then select
Refresh. It may take several minutes to detect printers. If the printer is not yet detected, connect
the machine and the computer with a USB cable, then select Refresh.

« If the printer is being used from another computer, a screen is displayed informing you of this
condition.

> Note

» This item has the same function as Update in the Canon IJ Network Tool screen.

Network Information
Displays the Network Information screen to confirm the network settings of the printer and the
computer.

= Network Information Screen

Display Warning Automatically
Enables or disables automatic display of the instruction screen.

When this menu is selected, the instruction screen is displayed if one or more ports are unavailable
for printing.

. Settings menu

Configuration...
Displays the Configuration screen to configure settings of the selected printer.

= Configuration Screen

»» Note

+ This item has the same function as Configuration... in the Canon IJ Network Tool screen.

Associate Port...
Displays the Associate Port screen and you can associate a port with the printer.

= Associate Port Screen

This menu is available when No Driver is displayed for the selected printer. Associating a port with
the printer enables you to use it.

Maintenance...
Displays the Maintenance screen to revert the network settings of the printer to factory default and
to mount the card slot as the network drive.

= Maintenance Screen

. Help menu

Instructions
Displays this guide.

About
Displays the version of IJ Network Tool.
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Status Screen

You can check the printer status and connection performance.

To display the Status screen, select Status from the View menu.

1% Note

» This screen is not available depending on the printer you are using.

* When using wired LAN, Signal Strength:, Link Quality: and Advanced Measurement... are not
available.

Im&m-ml 1
Signal rength
B1% -2
Lirk sty
% % -3
|
L 4

1. Device Status:

The device status is displayed as Available or Unavailable.

2. Signal Strength:

Indicates the strength of the signal received by the printer, ranging from 0% to 100%.

3. Link Quality:

Indicates the signal quality excluding the noise while communicating, ranging from 0% to 100%.

4. Advanced Measurement...

To examine the connection performance between the printer and the access point or between the printer
and the computer.

When you click, the Connection Performance Measurement is displayed.

= Connection Performance Measurement Screen
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Connection Performance Measurement Screen

15> Note

» This screen is not available depending on the printer you are using.

Displays to execute the connection performance measurement.

= Connection Performance Measurement Screen (Initial Screen)

= Connection Performance Measurement Screen (Completion Screen)

Connection Performance Measurement Screen (Initial Screen)

Click Next> to start measurement.

Thia veizard vell maasure the correction perfoemance bsiwesn the peanber and
then Bccesa point. and dapley whather & i3 sulable for prnting.
Chasch thaat the panber i tumed an_ and clck [Nesd]

'When the connection pesformancee is poor, place the panber closer to the access
between them, Poor

- R will 1akos B couple of minules 1o measune the cornaction
Hmmwﬂmmnﬂhm:nmj

Iratpuctiona o (T

Connection Performance Measurement Screen (Completion Screen)

Displays when the measurement is finished.

]aﬂ ﬁ’bj

Cormaction Pedomance bebwesn the Printer and the Access Point
—————e e ]

@ e .
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1. Connection Performance between the Printer and the Access Point:

A mark indicates the result of the connection performance measurement between the printer and the
access point.

9: Good connection performance
&: Unstable connection performance
@: Cannot connect

@: Measurement is canceled, or cannot measure

2. Remeasurement

Measures the connection performance again.

> Note

« If any messages appear on Overall Network Performance:, move the machine and access point as
instructed to improve the performance.

203



Maintenance Screen

Displays to perform Setting Initialization and Network Setup of the Card Slot.

To display the Maintenance screen, select Maintenance... from the Settings menu.

Setting Initialzation
Ta retuem Bhe porder setimgs Ba the faciony defaulls, chok [Indishas] .I
Intihze
Network Setup of the: Card Slot
¥y plary 1o use the cand slol via the networ:, sick [Sebup) 2
Status: Mot set Sehu
Insjructions: 0% Cancsl

1. Setting Initialization

Reverts all the network settings of the printer to factory default. Click Initialize to display the Initialize
Settings screen and click Yes to initialize the network settings of the printer. Do not turn off the printer
during initialization. Click OK when initialization is complete.

Performing initialization when connected over wireless LAN will break the connection, so perform setup
with the Setup CD-ROM or perform setup according to the instructions on our website.

2. Network Setup of the Card Slot
»» Note

 This item is not available depending on the printer you are using.

Status displays whether the card slot is mapped as a network drive.
When you click, the Network Setup of the Card Slot is displayed.
= Network Setup of the Card Slot Screen

204



Network Setup of the Card Slot Screen

»» Note

» This screen is not available depending on the printer you are using.

Displays settings of the card slot and allows you to map a card slot on the network as a network drive on the
computer.

Displays when you click Setup on the Maintenance screen.

= Network Setup of the Card Slot Screen (Setup Screen)

= Network Setup of the Card Slot Screen (Setup Failed Screen)
»» Note

* You can change the network settings of the printer using IJ Network Tool with USB connection after
initializing the LAN settings. To change the network settings using IJ Network Tool, activate the LAN

settings in advance.

Network Setup of the Card Slot Screen (Setup Screen)

Metwork Setup of the Card Slot E

Map the cand siot as a network deve bo this computer
Speeciby thes deves letber ared chick JOK]

I 1

= Lannll Eago1-»

Insjructions [ 0K Cancsl

1. Drive:

Select the drive letter to assign to the network drive.

2. Update

Reloads the drive letters that are unassigned in Computer (My Computer in Windows XP) and
displays them in the Drive: list.

Network Setup of the Card Slot Screen (Setup Failed Screen)

Display when the network setup of the card slot is failed.
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Communication with the Card Slof fadled .
Plaass refer io the [Instructions]. then click; [Retry].

1. Skip

Completes the setup without mapping a network drive to the card slot.

2. Retry

Returns to Network Setup of the Card Slot screen and re-executes the network drive mapping.

3. Cancel

Cancels the card slot setup. When IJ Network Tool is running over LAN, the Cancel button is displayed
grayed out and cannot be clicked.
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Associate Port Screen

Allows you to associate a created port with a printer driver.
Select the printer for which you want to change the association, then click OK.

13> Note

* You cannot print with the printer unless the printer driver is associated with the port.

o |
Conon B ™1
Microscht . PORTPROMPT:
Micregeft . SHRFAX:

mr_m

1. Model:

Displays the name of device specified as a destination port.

It is blank if the name of device is not detected.

2. Printer:

Displays the printer driver installed in the computer.

Select the printer for which you want to change the association.

3. OK

Performs association.
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Network Information Screen

Display the network information that is set for the printers and the computers.

To display the Network Information screen, select Network Information from the View menu.

&
Network Inforsation
Gereral Info.
L A A SN ER | i i
Wl;d!] ................. -l—l-l': —_—
OPFIMEEE . o o v 0o voaowonow o0 o 3 e R e P
MIEINP Port Name. . . . . . . . @ 60k Sl e .
DSNScarmer . . . v v v von e e R ey ey —
L T . R R | o g
(M0IRNP Port Mormitor Version . . . . . . 1 LA
spplication Info.
< *
Insipuctions [i 0K ][_cm.ﬂﬁﬂm]
_
1 2
1. OK

Returns to the Canon IJ Network Tool screen.

2. Copy All Information

All network information displayed is copy to the clipboard.
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Appendix for Network Communication

= Using the Card Slot over a Network

= \When the Printer Driver Is Not Associated with a Port
= About Technical Terms

= Restrictions

= About Firewall
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Using the Card Slot over a Network

22> Note

» This screen is not available depending on the printer you are using.

= Mounting the Card Slot as the Network Drive

= Restrictions on Card Slot Use over a Network

Mounting the Card Slot as the Network Drive

The card slot must be mounted to use it over a network.

To mount the card slot as the network drive, follow the procedure below.
1. Insert a memory card into the card slot of the machine.

2. Start up |J Network Tool.

3. Select the machine in Printers:.

4. Select Maintenance... on the Settings menu.

5. Click Setup.

Setting Intialzation
T retum the prinder settings Ba the faciony defeulls, chick [intislize].

Metwork Setup of the Cand Siot
¥ yeu plar: 1o use the cand slol via the nebwor, cick [Sebup)

[peain
g =

Insjructions oK Cancsl

Map the card sict a3 a network deve to this compuber
Speciy the déve letter and dick [OK].
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7. Make sure that the card slot is mounted.
When the card slot is mounted, the following icon appears on Computer (or My Computer).

canon_memory

-

Restrictions on Card Slot Use over a Network

» The card slot can be shared by multiple computers, if the machine is connected to a network. Multiple
computers can read files from a memory card in the card slot at the same time. However, while one
computer is writing a file into a memory card, other computers cannot access the same file.

* If your computer joins a domain, the card slot may not be mounted as the network drive.

* If you use the memory card stored the large size files or many files, a large amount of card access
may be generated. In this case, the operation in the memory card may be impossible or slow. Operate
after the Access lamp of the machine is lit.

* When you access the network drive for the card slot over the network, file names consisting of eight
or less lowercase letters (not including its extension) may be shown in uppercase.

For example, a file name such as "abcdefg.doc" will be "ABCDEFG.DOC", while a name such as
"AbcdeFG.doc" will appear the same.

The file is not actually renamed, but merely appears to be changed.

» When you enable a memory card in the card slot of the machine to be writable only from a USB-
connected computer, you cannot access the network drive of the card slot. On the other hand, when
you enable it to be writable only from a LAN-connected computer, the card slot is not detected via
USB. Make sure that the card slot setting is selected properly according to your connection method.

To read files from a memory card via USB and over a network, disable the function to write files to a
memory card from a computer. You cannot write files to a memory card in either way with this setting.

* When you enable a memory card in the card slot of the machine to be writable only from a LAN-
connected computer, you can write files to a memory card from a computer connected to a network.
Note that it may increase the risk that the data on the memory card is infected by computer viruses or
accessed illegally.

It is recommended to use the access control function of the machine or connect to the Internet via a
router. For information on using a router, contact your Internet service provider or a network device
manufacturer.

« If you write files to a memory card over a network when IJ Network Scanner Selector EX is not
running, the Date Modified of the files may not be proper. Make sure to start up IJ Network Scanner
Selector EX before you write files to a memory card over the network. For details, refer to "IJ Network
Scanner Selector EX Menu and Setting Screen” from the HOME of your product's Online Manual.
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When the Printer Driver Is Not Associated with a Port

If No Driver is displayed for the printer's name on the Canon IJ Network Tool screen, the printer driver is
not associated with a created port.

To associate a port with a printer driver, follow the procedure below.

1. Start up IJ Network Tool.

2. Select the printer displayed as No Driver on Name.

3. Select Associate Port... on the Settings menu.

The Associate Port screen is displayed.

Aasocisbe a port with an installed prinfer, Select 3 printer to associate with, and
chck JOK]

SfCoron M  funishls  Conon®8  FT]

G Caron BB Avalabls Conon 8]

@ Mcroach KPS 0. Avalable Mecrosolt . PORTPROMPT:
i Fax Evalable Microsoft . SHRFAX:

[P—— Back ok | | coee

4. Select a printer to associate with a port.

The list of the printers that the printer driver is installed is displayed at Printer: on the Associate Port
screen. Select a printer to associate with a created port.

5. Click OK.
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About Technical Terms

In this section, technical terms used in the manual are explained.

»A

Access Point

A wireless transceiver or base station that receives information from wireless clients/the machine and
rebroadcasts it. Required in an infrastructure network.

Ad-hoc

Client computer and machine setting where wireless communication occurs on a peer-to-peer basis,
i.e., all clients in with the same SSID/network name communicate directly with each other. No access
point is required. This machine does not support ad-hoc communication.

Admin Password

Administration password in IJ Network Tool to restrict access to network users. It must be entered to
access the printer and change printer settings.

When the printer's network settings are factory default, the admin password does not have to been
entered.

AES

An encryption method. It is optional for WPA. Strong cryptographic algorithm adopted within U.S.
government organizations for information processing.

Authentication Method

The method that an access point uses to authenticate a printer through a wireless LAN. The methods
are agreeable each other.
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When using WEP as an encryption method, the authentication method is able to fix to Open System
or Shared Key.

For WPA/WPA2, authentication method is PSK.
> Auto
The printer automatically changes its authentication method to match the access point.
o Open System

In this authentication method, the communication partner is authenticated without using WEP key
even if Use WEP is selected.

o Shared Key

In this authentication method, the communication partner is authenticated using the WEP key that
was set for encryption.

B

* Bonjour

A service built into Mac OS X operating system to detect the connectable devices on a network
automatically.

Cc

¢ Channel

Frequency channel for wireless communication. In the infrastructure mode, the channel is
automatically adjusted to match that set to the access point. This machine supports channels 1 to 13.
Note that the number of channels that can be used for your wireless LAN varies depending on the
region or country.

D

» Default Gateway

A relay device to connect to another network such as a router or a computer.

* DHCP server functionality
The router or the access point assigns an IP address automatically whenever the printer or the
personal computer on a network starts up.

* DNS server

A server that converts device names into IP addresses. When specifying IP addresses manually,
specify the addresses of both a primary and a secondary server.

F

¢ Firewall

It is a system that prevents an unlawful computer access in the network. To prevent, you can use the
firewall function of a broadband router, the security software installed in the computer, or operation
system for computer.
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» IEEE 802.11b
International standard for wireless LAN using the 2.4 GHz frequency range with a throughput of up to
11 Mbps.

- IEEE 802.11g
International standard for wireless LAN using the 2.4 GHz frequency range with a throughput of up to
54 Mbps. Compatible with 802.11b.

» IEEE 802.11n

International standard for wireless LAN using the 2.4 GHz and 5 GHz frequency ranges. Even when
using two or more antennas simultaneously or obtaining a bigger transfer rate than before by using
multiple communication channels at the same time, the transmission speed may be influenced by the
connected apparatus.

At the maximum transfer rate of 600 Mbps, it is possible to communicate with multiple computer
terminals within a dozen or so metre radius.

Compatible with 802.11b and 802.11g.

« Infrastructure

Client computer and machine setup where all wireless communications pass through an access point.

« |IP Address

A unique number with four parts separated by dots. Every network device that is connected to the
Internet has an IP address. Example: 192.168.0.1

An IP address is usually assigned by an access point or a DHCP server of the router automatically.

* IPv4/IPv6

They are internetwork-layer protocol used on the internet. IPv4 uses 32-bit addresses and IPv6 uses
128-bit addresses.

K

* Key Format

Select either ASCII or Hex as the WEP key format. The character that can be used for the WEP key
differs depending on the selected key formats.

> ASCII

Specify with a 5 or 13-character string that can include alphanumeric and underscore
characters. It is case-sensitive.

o Hex
Specify a 10-digit or 26-digit string that can contain hexadecimal (0 to 9, A to F, and a to f).
* Key Length

Length of the WEP key. Select either 64 bits or 128 bits. Longer key length allows you to set a more
complex WEP key.
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L

+ Link Quality

The status of connection between the access point and the printer excluding noise (interference) is
indicated with a value from 0 to 100%.
LPR

A platform-independent printing protocol used in TCP/IP networks. It is not supported bidirectional
communication.

MAC Address

Also known as the physical address. A unique and permanent hardware identifier that is assigned to
network devices by its manufacturer. MAC addresses are 48 bits long and are written as a
hexadecimal number separated by colons, i.e., 11:22:33:44:55:66.

Operation Status

Indicates the status on whether the printer can be used.

Proxy server

A server that links a LAN-connected computer to the Internet. When using a proxy server, specify the
address and the port number of the proxy server.

PSK

An encryption method employed by WPA/WPA2.

Router

A relay device to connect to another network.

Signal Strength

The strength of the signal received by the printer from the access point is indicated with a value from
0 to 100%.

SSID

Unique label for wireless LAN. It is often represented such as a network name or an access point
name.

SSID distinguishes one wireless LAN from another to prevent interference.
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The printer and all clients on a wireless LAN must use the same SSID in order to communicate with
each other. The SSID can be up to 32 characters long, and is made up of alphanumeric characters.
The SSID may also be referred to by its network name.

+ Stealth
In the stealth mode, an access point hides itself by not broadcasting its SSID. The client must specify
the SSID set to the access point to detect it.

* Subnet Mask

IP address has two components, the network address and the host address. Subnet Mask used to
calculate the Subnet Mask address from the IP address. A Subnet Mask is usually assigned by an
access point or a DHCP server of the router automatically.

Example:

IP Address: 192.168.127.123

Subnet Mask: 255.255.255.0

Subnet Mask Address: 192.168.127.0

« TCP/IP

Suite of communications protocols used to connect hosts on the Internet or the LAN. This protocol
allows different terminals to communicate with each other.

* TKIP

An encryption protocol employed by WPA/WPA2.

+ USB

Serial interface designed to enable you to "hot-swap" devices, i.e., by plugging and unplugging them
without turning off the power.

w

* WCN (Windows Connect Now)
Users running Windows Vista or later can obtain the setting information directly via wireless network
(WCN-NET).

+ WEP/WEP Key

An encryption method employed by IEEE 802.11. Shared security key used to encrypt and decrypt
data sent over wireless networks. This printer supports key length of 64 bits or 128 bits, key format of
ASCII code or Hexadecimal, and key number of 1 to 4.

* Wi-Fi

International association that certifies interoperability of wireless LAN products based on the IEEE
802.11 specification.
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This machine is a Wi-Fi authorized product.

* Wireless LAN
A network that, instead of being connected by physical wires, is connected by a wireless technology,
such as Wi-Fi.

« WPA

Security framework announced by the Wi-Fi Alliance in October 2002. The security has been
strengthened more than WEP.

o Authentication

WPA defines the following authentication methods: PSK that can be used without an
authentication server, plus WPA-802.1x that do require an authentication server.

This machine supports WPA-PSK.
o Passphrase
This encrypted key is used to perform WPA-PSK authentication.
The passphrase should be a string of 8 to 63 alphanumeric characters or a 64-digit hexadecimal
value.
+ WPA2

Security framework released by the Wi-Fi Alliance in September 2004 as a later version of WPA.
Provides a stronger encryption mechanism through Advanced Encryption Standard (AES).

o Authentication

WPAZ2 defines the following authentication methods: PSK that can be used without an
authentication server, plus WPA2-802.1x that do require an authentication server.

This machine supports WPA2-PSK.
o Passphrase
This encrypted key is used to perform WPA2-PSK authentication.

The passphrase should be a string of 8 to 63 alphanumeric characters or a 64-digit hexadecimal
value.

* WPS (Wi-Fi Protected Setup)
WPS is a standard for easy and secure establishment of a wireless network.
There are 2 primary methods used in the Wi-Fi Protected Setup:
PIN entry: a mandatory method of setup for all WPS certified devices

Push button configuration (PBC): an actual push button on the hardware or through a simulated push
button in the software.
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Restrictions

If you use a printer over the wireless LAN, the printer may recognize nearby wireless systems, you should
set a network key (WEP, WPA, or WPA2) to the access point to encrypt wireless transmission. Wireless
communication with a product that does not comply with the Wi-Fi standard cannot be guaranteed.

Connecting with too many computers may affect the printer performance, such as printing speed.
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About Firewall

A firewall is a function of the security software installed in the computer or operation system for computer,
and is a system that is designed to prevent unauthorized access to a network.

Precautions When a Firewall Function is Enabled
« A firewall function may limit communications between a printer and a computer. This may disable
printer setup and communications.

» During the printer setup, you may be prompted to enable or disable communications, depending on
the firewall function of the security software or operation system. If so, choose to enable
communications.

* When using IJ Network Tool, you may be prompted to enable or disable communications, depending
on the firewall function of the security software. If so, choose to enable communications.

« If you cannot set up the printer, temporarily disable the firewall function of the security software or
operation system.

32 Important

+ If you disabled the firewall function, disconnect your network from the Internet.

» Some applications (like the network configuration software) override firewall settings. Check the
application's settings beforehand.

« If the printer you use is set to Get IP address automatically, the IP address changes every time the
printer connects to the network. This may disable printer setup and communications, depending on
the firewall settings. In this case, either change the firewall settings or assign a fixed IP address to the
printer. An IP address can be set using |J Network Tool.

= Changing the Settings in the Wireless LAN Sheet

= Changing the Settings in the Wired LAN Sheet

When assigning a fixed IP address to the printer, you will need to specify an IP address with which the
computer can communicate.

7> Note

» For the operation system firewall settings or the security software firewall settings, refer to the
instruction manual of the computer or software, or contact its manufacturer.
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Tips for Ensuring Optimal Printing Quality

® Useful Information about Ink
“ Key Points to Successful Printing

“ Be Sure to Make Paper Settings after Loading Paper

® Canceling a Print Job
® Key to Enjoying Consistent Printing Quality

“ Precautions for Safe Transport of the Machine
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Useful Information about Ink

How is ink used for various purposes other than printing?

Ink may be used for purposes other than printing. Ink is not only used for printing, but also
for cleaning the print head to maintain the optimal printing quality.

The machine has the function to automatically clean the ink jet nozzles to prevent clogging.
In the cleaning procedure, ink is pumped out from the nozzles. Used ink for nozzle cleaning
is limited to a small amount.

Does black-and-white printing use color ink?

Black-and-white printing may use ink other than black ink depending on the type of printing
paper or the settings of the printer driver. So, color ink is consumed even when printing in
black-and-white.
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Key Points to Successful Printing

Check the machine status before printing!

« Is the print head OK?

If a print head nozzle is clogged, print will be faint and papers will be wasted. Print the
nozzle check pattern to check the print head.
= Maintenance Procedure

« Is the inside of the machine smeared with ink?

After printing large quantities of paper or performing borderless printing, the area where
papers go through may get smeared with ink. Clean the inside of your machine with
Bottom Plate Cleaning.

= Cleaning the Inside of the Machine (Bottom Plate Cleaning)

Check how to load the paper correctly!

« Is the paper loaded in the correct orientation?

To load paper in the front tray, load paper WITH THE PRINTING SIDE FACING
DOWN.

= | oading Paper

-~

« Is the paper curled?

The curled paper causes paper jam. Flatten the curled paper, then reload it.

= "Load the paper after correcting its curl." in Paper Is Smudged/Printed Surface Is
Scratched.
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Be Sure to Make Paper Settings after Loading Paper

If the media type setting is not the one for the loaded paper, printing results may not be
satisfactory. After loading paper, be sure to select the appropriate media type setting for the
loaded paper.

= Print Results Not Satisfactory

There are various types of paper: paper with special coating on the surface for printing
photos with optimal quality and paper suitable for documents.

Each media type has specific preset settings, such as how ink is used and sprayed,
distance from nozzles, etc., so that you can print on that type with optimal image quality.
This allows you to print with the settings best suited for the loaded media type just by
selecting that media type.
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Canceling a Print Job

Never press the ON button!

If you press the ON button while printing is in progress, the print data sent from the
computer queues in the machine and you may not be able to continue to print.
Press the Stop button to cancel printing.
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Key to Enjoying Consistent Printing Quality

The key to printing with the optimal printing quality is to prevent the print head from drying
or clogging. Always observe the following rules for optimal printing quality.

Never disconnect the power plug until the power is turned off!

If you press the ON button to turn off the power, the machine caps the print head (nozzles)
automatically to prevent from drying. If you disconnect the power plug from the wall outlet
before the power is turned off (while the ON lamp is lit or flashing), the print head will not be
capped properly and this will cause drying or clogging.

When disconnecting the power plug, make sure that the ON lamp is not lit.

= Notice for Unplugging the Power Cord

Print periodically!

Just as the tip of a felt pen becomes dry and unusabile if it has not been used for a long
time, even if it is capped, the print head too, may become dried or clogged if the machine
has not been used for a long time.

We recommend you to use the machine at least once a month.

»» Note

Depending on the type of paper, ink may blur if you trace the printed area with a
highlight pen or paint-stick, or bleed if water or sweat comes in contact with the printed
area.
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Precautions for Safe Transport of the Machine

When relocating the machine, make sure of the following.
»» Important

When sending the machine for repair
Pack the machine in a sturdy box so that it is placed with its bottom facing down, using
sufficient protective material to ensure safe transport.
With the FINE cartridge left installed in the machine, press the ON button to turn off the
power. This allows the machine to automatically cap the print head, thus preventing it
from drying.
After packing, do not tilt the box containing the machine or turn it on its side or upside
down. Doing so may cause the ink to leak during transport and cause damage to the
machine.
When a shipping agent is handling transport of the machine, have its box marked "THIS
SIDE UP" to keep the machine with its bottom facing down. Mark also with "FRAGILE"
or "HANDLE WITH CARE".

1. Turn the machine off.

2. Confirm that the ON lamp is off and unplug the machine.
= Notice for Unplugging the Power Cord
» Important

Do not unplug the machine while the ON lamp is lit or flashing, as it may cause
malfunction or damage to the machine, making the machine unable to print.

3. Retract the paper output support, then close the paper output tray.
Retract the paper support with the output tray extension closed.

4. Close the front cover.

5. Disconnect the printer cable from the computer and from the machine,
then disconnect the power plug from the machine.
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6. Use adhesive tape to secure all the covers on the machine to keep them
from opening during transportation. Then pack the machine in the plastic
bag.

7. Attach the protective material to the machine when packing the machine
in the box.
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Legal Limitations on Use of Your Product and Use of
Images

It may be unlawful to make copies of, scan, print, or use reproductions of the following
documents.

The list provided is non-exhaustive. When in doubt, check with a legal representative in
your jurisdiction.

@« Paper money

Money orders

Certificates of deposit

Postage stamps (canceled or uncanceled)
Identifying badges or insignias

@« Selective service or draft papers

@« Checks or drafts issued by governmental agencies

Motor vehicle licenses and certificates of title
Traveler's checks

Food stamps

Passports

Immigration papers

Internal revenue stamps (canceled or uncanceled)

Bonds or other certificates of indebtedness
Stock certificates
@« Copyrighted works/works of art without permission of copyright owner
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Specifications

General Specifications

|Printing resolution (dpi)

4800* (horizontal) x 1200 (vertical)

* Ink droplets can be placed with a pitch of 1/4800 inch at
minimum.

Interface

USB Port:

Hi-Speed USB *1

LAN Port:

Wireless LAN: IEEE802.11n/IEEE802.11g/IEEE802.11b *2

"1 A computer that complies with Hi-Speed USB standard is
required. Since the Hi-Speed USB interface is fully upwardly
compatible with USB 1.1, it can be used at USB 1.1.

*2 Setup possible through WPS (Wi-Fi Protected Setup), WCN
(Windows Connect Now) or Cableless setup.

|Print width

8 inches/203.2 mm

(for Borderless Printing: 8.5 inches/216 mm)

|Operating environment

Temperature: 41 to 95 °F (5 to 35 °C)
[Humidity: 10 to 90 % RH (no condensation)

Storage environment

Temperature: 32 to 104 °F (0 to 40 °C)
[Humidity: 5 to 95 % RH (no condensation)

[Power supply

AC 100-240 V, 50/60 Hz

|Power consumption

|Printing (Copy): Approx. 16 W *1
Standby (minimum): Approx. 1.7 W *1*2
|OFF: Approx. 0.3 W

*1 Wireless LAN is active.

*2 The wait time for standby cannot be changed.

|[External dimensions

Approx. 17.7 (W) x 12 (D) x 6 (H) inches
Approx. 449 (W) x 304 (D) x 152 (H) mm

* With the Front Cover retracted.

Weight

Approx. 11.9 Ib (Approx. 5.4 kg)
* With the FINE Cartridges installed.

|Canon FINE Cartridge

Total 1792 nozzles (BK 640 nozzles, C/M/Y each 384 nozzles)

Copy Specifications

|Mu|tip|e copy

max. 21 pages

|Reduction/EnIargement

Fit-to-page
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Scan Specifications

Scanner driver

Windows: TWAIN 1.9 Specification, WIA
Mac OS: ICA

[Maximum scanning size

Ad/Letter, 8.5" x 11.7"/216 x 297 mm

Scanning resolution

|Optical resolution (horizontal x vertical) max: 1200 x 2400
dpi 1
linterpolated resolution max: 19200 x 19200 dpi *2

*1 Optical Resolution represents the maximum sampling rate
based on ISO 14473.

*2 Increasing the scanning resolution will limit the maximum
possible scanning area.

|Gradation (Input/Output)

Gray: 16 bit/8 bit
Color: 48 bit/24 bit (RGB each 16 bit/8 bit)

Network Specifications

[Communication protocol

TCP/IP

IWireless LAN

Supported Standards: IEEE802.11n/IEEE802.11g/
IEEE802.11b

Frequency bandwidth: 2.4 GHz
Channel: 1-11 or 1-13

* Frequency bandwidth and available channels differ
depending on country or region.

Transfer speed (Standard value):
IEEE802.11n: max. 150 Mbps
IEEE802.11g: max. 54 Mbps
IEEE802.11b: max. 11 Mbps

* These values are a theoretical maximum transmission speed
between the printer and an equivalent network device, and do
not indicate the actual transmission speed obtained.

|ICommunication distance: Indoors 164 feet/50 m

* Effective range varies depending on the installation
environment and location.

Security:

WEP (64/128 bits)

WPA-PSK (TKIP/AES)

WPA2-PSK (TKIP/AES)

Setup:

WPS (Push button configuration/PIN code method)

231




WCN (WCN-NET)
Cableless setup

Other Features: Administration password

Minimum System Requirements

Conform to the operating system's requirements when higher than those given here.

Windows

\Windows 8

\Windows 7, Windows 7 SP1

Windows Vista SP1, Windows Vista SP2
Windows XP SP3 32-bit only

|Operating System

|Browser Internet Explorer 8 or later

3 GB

. INote: For bundled software installation.
|[Hard Disk Space

The necessary amount of hard disk space may be changed
without notice.

|Disp|ay XGA 1024 x 768
Mac OS
|Operating System [Mac OS X v10.6.8 or later
[Browser Safari 5 or later
1.5 GB

. INote: For bundled software installation.
[Hard Disk Space

The necessary amount of hard disk space may be changed
without notice.

|Disp|ay XGA 1024 x 768

Other Supported OS

Some functions may not be available with each OS. Refer to the manual or the Canon web
site for details on operation with iOS, Android, and Windows RT.

Mobile Printing Capability

Apple AirPrint

|Google Cloud Print

@ An internet connection is required to view the Online Manual.
« Windows: Operation can only be guaranteed on a computer with Windows 8, Windows
7, Windows Vista or Windows XP pre-installed.
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@« Windows: A CD-ROM Dirive or internet connection is required during software
installation.

@« Windows: Internet Explorer 8, 9 or 10 is required to install Easy-WebPrint EX.
Easy-WebPrint EX for Internet Explorer 10 can be downloaded from the Canon web
site.

« Windows: Some functions may not be available with Windows Media Center.

@« Windows: .NET Framework 4 or 4.5 must be installed to use the Windows software.

« Windows: XPS Essentials Pack is required to print on Windows XP.

@« Mac OS: Hard Disk must be formatted as Mac OS Extended (Journaled) or Mac OS
Extended.

@« Mac OS: For Mac OS, an internet connection is required during software installation.

@« Windows: The TWAIN driver (ScanGear) is based on the TWAIN 1.9 Specification and
requires the Data Source Manager bundled with the operating system.

Specifications are subject to change without notice.
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